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UniLogic 1.41.xx introduces a brand new powerful software feature to broaden your project potential: BACnet
Client. This feature complements the existing BACnet IP Server support, enabling UniLogic PLCs to communicate with
BACnet-compatible devices via both Ethernet and Serial MS/TP. Both communication methods can operate

concurrently.

The BACnet Client allows integration with multiple BACnet servers and supports both periodic and aperiodic data
exchange. Configuration is straightforward and integrates with Ladder logic, enabling seamless data transfer

between UniLogic and building management systems.

This release also introduces a performance enhancement: Improved Compilation Time. This upgrade delivers faster
and more scalable compilation by resolving key performance bottlenecks. Through comprehensive optimization and
the introduction of parallel processing across multiple system components, download times have been reduced.

BACnet Client

NEW in Remote URB
1/0

Improved Compilation
Time

OPC-UA

This feature complements the existing BACnet IP Server support with BACnet MS/TP and BACnet
IP client functionality, enabling seamless integration with building management systems through
straightforward configuration that integrates directly with Ladder logic.

Note that BACnet Client requires a license purchase, available from your Unitronics' sales
representative.

Unitronics offers you a One-hour Trial Offer to enable you to explore this new exciting feature.
Note that each time you power up your controller, you can restart the One-Hour Trial Offer.

To learn how to activate the Trial Offer, refer to the BACnet Client topic in the UniLogic Help.

Note: The BACnet client is available for the UniStream Built-In and the UniStream PLC series.

Hardware Configuration now offers new 1/O modules to our line of URB Remote I/0. These
models use 18 RTD (push-in) terminal blocks instead of the existing 20 pins (URS-08RT-2 and URS-
08TC-2).

e URS-08RT-8: This thermal module features 8 Digital Inputs, RTD/Resistance Input.

e URS-08TC-8: This module features 8 Digital Inputs, TC/mV Input.

This enhancement addresses performance bottlenecks that were causing extended download
times, delivering faster and more scalable compilation processes.

OPC-UA Authentication Enhancements:

e OPC-UA now supports Username/Password authentication in addition to the existing
Anonymous mode.

e Inthe Server Settings, a new field allows you to select the Authentication Mode.

e When Username/Password is selected:



A new Users section is available, where you can define users, passwords, and assign
them to one of two fixed groups: Admin or User.

In the Address Space, a new Access Level option is available: Admin Group
Read/Write - Admin users can read and write to data tags within the PLC, while all
other users will have read-only access.

OPC-40082-2 for Plastic/Rubber Industry (EUROMAP 82.2) Hot Runner Device (HRD) Support:

REST API .

SD Card Management o
Improvements

UniStream now supports the OPC-UA HRD (Hot Runner Device) Address Space.
Requires a license purchase, available from your Unitronics' sales representative.

One-hour Trial Offer: This free, fully functional trial offer enables you to explore
UniStream's HotRunner functionality for 60 minutes at a time.

Supports up to 3 zones.

Provides structured access to diagnostics, machine configuration, maintenance,
operation, and zone management.

GET FILE Request Method: you can now download files directly from web servers to SD
card or USB storage using the new GET FILE request method.

File Parameters Configuration: Use the new dedicated File Parameters for configuring
file paths, storage location selection, timeout settings, and retry attempts for reliable file
downloads.

Authorization Method: you can now use long QAuth tokens up to 1,100+ characters
(previously limited to 256), with buffer-based storage for seamless API integration.

Safe Remove SD: Use this Project-level Action with an optional Status Tag to monitor
removal progress and results.

Re-mount SD Card: Together with Safe Remove SD, the Re-mount SD Card action
eliminates the need to remove or reinsert the SD card physically. In some instances, it can
also unlock a locked SD card and enable you to continue working without rebooting.

EXT4 Support: You can now format SD cards and DOK devices as EXT4 directly from the
system. EXT4 offers improved resilience against power failures, reducing the risk of data
corruption compared to FAT32. This is particularly important since Windows cannot
format to EXTA4 file system.

Note:

- You must reboot the system after formatting for the changes to take effect.

- Make sure only one DOK is connected during formatting.

UniCloud Asset You can now register PLCs, create assets, and activate UniCloud communication directly from
Registration Unilogic.

New PLC UniCloud Connectivity: Register PLC, Create Asset, Activate Asset,
Enable/Disable Remote Access, and Start/Stop data transmission.

Integration Checklist: Navigate to and verify configuration of Tags, Alarms, Remote

Access, and Data Backup (marked 'a'when complete).



Alarms

New Default Project
Options

o Safety Enhancement: 'Select Asset Type' is disabled if an asset type already exists in the
project to prevent accidental changes.

Alarms now support several new features:
e Alarms Struct:

o New Global tags enable you to track the total number of alarms pending reset,
acknowledgment, or viewing, along with a flag indicating if any alarms are pending.

o New Group tags enable you to include an array to track the number of active alarms for
each group, as well as arrays for alarms pending reset, acknowledgment, and viewing,
organized by group. Each array will have a size of 32 to accommodate all
groups. Additionally, it will have a bitfield indicating if any alarms in a group are pending
(Reset, ACK, or View).

e Properties Window: Alarm Limits

To reduce panel RAM usage and enhance performance, the default values for Alarm configuration
have been modified to limit the number of Alarm rows in both Summary and History widgets to a
maximum of 32.

A compile warning message has been introduced for projects in which these limits exceed 32.
e Properties Window: Terminology Updates

The terminology in the Alarms Properties Window has been updated to improve clarity:

Previous Term New Term
Notification Banner Alarm Indicator
Banner Color Mode Indicator Color Mode
Banner Color Indicator Color
Banner Location Indicator Location

Banner Type (drop-down options) | Alarm Indicator Type (drop-down options)

e large e |con + Banner

e Small e lIcon only

e None e None (No icon or banner)
Is visible when idle Show when Idle
Is Snooze Button Visible Show Snooze Button

These changes are visual terminology updates only and do not affect existing functionality.

The latest update introduces the ability to configure existing project options as default global
settings, improving consistency and efficiency when creating new projects. These settings can be
accessed under Project > Options, which simplifies the setup process for new projects.



Global Tags

Password-Protect ALL
Project Elements via
Solution Explorer

New HMI Elements

General - You can now set default values for auto-starting online mode, using ping for
discovery, showing project differences, enabling MODBUS advanced functions,
configuring power flow color, and defining the Ladder editor's initial zoom level.

HMI/Web Designer — Added the ability to configure default settings for auto-fitting HMI
screens and web pages, setting a default web page background color, and selecting a
default theme for new projects.

Print Options — You can now define default Ladder tag input sizes with options ranging
from Normal to Extra Extra Large.

Default Regional Settings — Introduced the ability to pre-define CSV delimiters, thousands
separators, and decimal symbols to match regional preferences.

Default Panel IP Settings — New global defaults enable you to pre-configure IP addresses,
subnet masks, and gateways for new panels.

DNS Servers — You can now define default primary, secondary, and tertiary DNS servers.
DHCP — A new option enables or disables DHCP by default for automatic IP assignment.

Default CPU IP Settings — You can now configure default CPU network settings, including
IP address, subnet mask, gateway, and TCP keep-alive parameters.

Default VNC Passwords — Introduced the ability to pre-define VNC access settings,
including enabling VNC, full-access passwords, and view-only passwords.

Proxy Settings — You can now set default proxy configurations, including no proxy, system
proxy, or manual proxy settings with server, port, username, and password fields.

Alarms Default Configuration — Added a new global setting to pre-define default alarm
configurations for all new projects.

Logging — You can now enable or disable log downloads by default to streamline
troubleshooting and analysis.

You can now quickly find the desired tag type using a searchable combo box in the Tag Editor.

When selecting a type, a filter text box appears if there are 7 or more available types, allowing

case-insensitive filtering with highlighted matches. The drop-down resets upon reopening,

ensuring a streamlined selection process.

You can now secure your entire project with a single action by right-clicking on the Project in the

Solution Explorer, selecting Protect All, and establishing one password for comprehensive

protection—later, simply right-click the Project again, choose Unprotect All, and enter your

password to unlock all elements simultaneously.

a.

Simple Elements: Now includes an Ellipse widget, used to display a static elliptical shape.

Graphs/Meters Elements: Now includes a Stacked Chart widget, used to visualize
multiple data series stacked in a single chart.

Legacy Elements: A new Legacy group has been added. It includes widgets that rely on
legacy data structures and workflows using direct memory access - such as integer arrays
representing ASCII strings.

The Legacy group elements include:

ASCII String widget, used to display text from an array of integers as ASCII characters.



HMI Editor Additions

b. Password ASCII String widget, used to input masked text stored as ASCII values in an
integer array.

Data Table: Use the new 'Tag: Edit Enabled’ option in the Data Table (DT)
widget to assign a BIT tag to enable or disable the Edit button dynamically. The Edit
button remains functional only if the Data Table is not marked as Read-Only.

e Combo Box: Use the new 'Dynamic’ option in the Location parameter to enable the use
of String tags and constant strings in the Options list. This provides greater flexibility for
creating context-sensitive drop-downs while maintaining copy/paste and export/import
functionality.

Note: Dynamic combo boxes are not supported in web server exports.

e Numeric Box: Use the new Ranges property for Numeric Box elements to dynamically
change background and foreground colors based on tag values.

Web Server You can now secure your PLC web applications with HTTPS protocol support, bringing improved

security and data protection to your web server communications.

LF: Store Not Bit Use this Ladder function to invert the state of an input bit and store its logical NOT value into a

destination bit.

LF: Gray Code to Use this Ladder function to convert data received in Gray Code format into its equivalent

Decimal

decimal value.

Additional Features

Connection Cancellation: You can now cancel PLC connection attempts that are in progress. When initiating
a Download or going Online with a PLC that isn't properly connected, you'll find a new Cancel button on the
"Connection Verification" dialog.

Motion: CAM Table enhancements and system updates.

FTP Client: added support for selecting FTP Transfer Modes (Passive/Active) and specifying custom Port or
Port Ranges for Active mode.

Via Hardware Configuration, you can now configure VNC Server settings to include visible pointer control
and touch input functionality, ensuring compatibility with UniCloud.

User Access Control: We've introduced an improved user session control feature in the UAC properties, Auto
Logoff, and Return to Home Screen. Note: to enable this functionality, you must enable 'Set Touch bit' at
UniApps>Network>VNC Server>General.

Find and Replace: This functionality, accessible from Ribbon > Edit > Find and Replace OR by
pressing CTRL+H, is being enhanced to allow more flexible type replacements while maintaining logical
compatibility. Note: incorrect replacements may result in compilation errors; therefore, verify that the
proposed replacement maintains the intended logical flow and data integrity of the program.

Message Composer: You can now use constant values in the Decimal Point Location field for Number
Variables in scanned messages.

Options > Localization: This version includes German language localization.

Buffers: You can now create and use buffers size up to 8192 bytes (8 KB).



UID-0808THS counters now support INT32 (signed) format, enabling proper counting in both directions
without underflow when pulses move backward. Note: projects using UID-0808THS counters with modules
running boot version 1.1 or lower cannot be upgraded to this version or higher.

Bugs Fixed in this version

ForEach Loops:

-Copying and pasting Ladder elements within a ForEach loop could create a duplicate "Current Item" variable
(e.g., "Current Item_1") if the type was different, causing the loop to become unusable.

-using "Current item" in a 'Copy buffer to tag' function within a 'For Each' loop caused compilation errors.

Custom Control:

-UniLogic enabled assigning a Writable Parameter tag of a different type in the HMI than the type defined in
the Custom Control (CC). Note: This fix may cause compilation errors in existing projects where the Writable
Parameter tag type in the HMI does not match the type defined in the CC. You should review and update
your projects accordingly.

-when using a Message Box with a Set Bit action on a button inside a Custom Control, the message box did
not function correctly if the bit tag was passed as a parameter.

Calendar Widget Date Range Extension: The date range has now been expanded to support selections
through December 31, 2037.

The FTP Server now supports usernames containing backslash characters.

FTP Compare File: In some instances, the function would complete successfully (with the FTP server variable
indicating completion) but fail to populate the status variable in the main application.

Data Sampler:

- The Sample Time column in CSV files used period ('.') as decimal separator even when comma (',') was
selected in Data Sample structure. Note: This setting is specific to the Data Sampler's internal number
formatting and is unrelated to the CSV Delimiter setting in regional options.

- active .usmp files were not properly backed up during system powerup, preventing data loss during power
cycle events.

HMI:

- In certain cases, Password Box and Numeric Password Box widgets would lose their authentication-specific
action properties (succeeded/failed options) when copied between HMI screens, incorrectly displaying
generic input actions (press/release/click) instead.

- In certain cases, copying and pasting a Linear Gauge with an INT32 Value (Range Bar) on the same screen
caused a compilation error.

- In certain cases, when entering Online mode, HMI lines would disappear.

HMI/Web Elements: copy-paste and repositioning of grouped HMI/Web elements no longer cause incorrect
misaligned placement after editing in the property grid, downloading to PLC, or reopening the project.

CAN Layer2: US15 received its own transmitted CAN messages, causing undesirable behavior in certain
cases.

The VNC Touch Bit now remains ON while a screen button is being pressed and turns OFF only upon release.

Modbus: Using the Write/Read Multiple Registers function with a Modbus serial slave set to Version 2.0
caused data overlapping, where read addresses incorrectly displayed values intended for write addresses.

Project-level Global Action 'Safe Remove SD' could incorrectly trigger an 'SD Lock' and delete SD card
contents.



ST Logic: Comparing negative values multiplied by an expression (e.g., variable x) returned incorrect results.
Alarm Summary checkbox status column no longer displays a double check mark.

UniLogic would crash during project compilation when a TC8 module was connected through an |10 Adapter
in US15 projects.

EtherCAT: Initialization Status may return status 4, Initialization Failure, when using more than 4 total cyclic
and virtual axes combined. A compilation error has been added to prevent runtime failures and provide clear
feedback.

OPC-UA client: The system incorrectly used the hostname instead of the static IP in certificates, even when
no hostname was configured, causing "BadHostname" errors during client connections.

Corrected object addresses for Stopper Torque and Blocking Time parameters in CANopen Homing
Methods.

In certain cases, PLCs could not go online due to unsupported cipher suites, causing TLS handshake failures.
UniApps, Auto-Sync: PLC time synchronization failed due to cached API output.
UID-0808THS: Incorrect actual position displayed during PTO back-and-forth movement.

Data Tables: When the ‘Show Array Member Names’ checkbox was enabled, names were not displayed and
toggling the option had no effect.

UCR Router: Initialization might fail if the password contained special characters or if the model was
incorrectly identified.

Change Summaries for Previous Versions begin on the following page.



UniLogic® V 1.40.135 UNISTREAM® OS 1.40.139 July, 2025

This Service Pack provides the new functions and bug fixes listed below.

Note: This version requires you to update your PLC firmware.

New Functions

UniCloud: now includes a new feature enabling users to programmatically control the Secure Remote Access
(SRA) functionality directly from Ladder Logic, providing more flexibility and automation options for remote
access management.

Previously, SRA control was only available through UniApps, limiting when and how users could enable or
disable remote connections.

The new feature adds two Global Actions; Stop UniCloud SRA and Start UniCloud SRA, that become
available automatically when UniCloud is enabled in the application, and can be triggered from various Ul
elements and logic conditions.

MQTT: Subscription Parameters now supports saving parsed JSON results directly to SD file storage.
REST API: Response Parameters now supports exporting parsed JSON responses directly to SD file storage.

USL Displays: configuration options now include selection by hardware model for easier setup. Navigate
to Hardware Configuration>Controller Model>Properties Window>VNC Server Resolution to access this
feature.

Bugs fixed in this patch

LF: SD File Operations: when using literal strings as file path parameters, the 'Read Line from File on SD'
Ladder function would fail with status -2.

Modbus: when changing a Modbus TCP slave IP address through UniApps, the Modbus TCP master would
freeze despite this configuration change being a supported operation.

UMD-B5: when selecting torque limit units other than "0.1% Tn" in the UMD-B5 Axis configuration, users
encountered an issue where attempting to enter values resulted in "NaN" being displayed.

HMI: when creating rectangles with rounded corners in UniLogic HMI screens, the corner radius settings
would reset after restarting the application. This issue specifically affected users with Ul language settings in
Polish, Chinese, Czech, Korean, Russian, and Turkish.

HMI:

-when tag names containing ("\u") were used in Audit values, the HMI Service would fail to start, displaying
an indefinite hourglass and eventually a black screen.

-when Custom Control names contained quotation marks (") and included HMI elements with actions, the
PLC would become unresponsive after download, showing an hourglass screen or black display instead of
the expected startup screen.

RedFish Protocol:
-Incorrect Redfish version returned by Chassis endpoint
-Incorrect Thermal Equipment response body text that used "CoolingUnits" instead of "CDUs"

Emails: when configured to use port 25 with both Use TLS and StartTLS Support disabled, Sendmail
incorrectly attempted to send emails using SSL.

CANbus "Sniffer Filter": in certain cases, struct members or array elements used as tags in CAN sniffer
configurations were not properly recognized, particularly when defining operational modes with power-up
values.



When certain analog input pairs were configured with mixed signal types (voltage/current), the voltage input
would read at half its proper range (0-5V instead of 0-10V) and current inputs would display incorrect fixed
values. May impact TA32 models.

LF: Set DTI Column Value: when negative index values were passed to DTI column operations, CPU errors
occurred.

SMS: in certain cases, when sending SMS messages with string variables in the message body, the first digit
of the variable was incorrectly appended to the destination phone number, causing messages to be
delivered to wrong recipients.

Export Project File: entering a valid serial number under “Allowed PLCs” during project export or download
file creation would result in the value not being saved.

Ethernet/IP: Structured-Text compilation error when referencing EIP structs with consecutive underscores.

Retained tags' initial values not loaded when importing applications via USB DOK.

Change Summaries for Previous Versions begin on the following page.



UniLogic® V 1.40.103 UNISTREAM® OS 1.40.112 March, 2025

This Service Pack provides the new functions and bug fixes listed below.

Note: This version requires you to update your PLC firmware.

New Functions

Redfish: now includes significant enhancements to the Redfish Protocol, the new Control Object brings
control capabilities that were previously unavailable in the protocol, including the ability to connect sensors,
define allowable values, associate with multiple sensors, and link to related system components. The update
introduces robust control mechanisms for cooling systems, including start/stop functionality, parameter
adjustments, and mode selection.

Load Config .INI:

-now enables setting the 'PLC Name', allowing machine differentiation without sharing the UniApps
password.

-now enables setting the 'CANbus baud rate’, allowing configuration without accessing UniApps for
enhanced cyber-security.

REST API: now enables configuring custom HTTP Headers. This enhancement supports projects that require
custom headers to be set by the user.

|0-Link: now supports 2 New Digital Hubs
ULK-1616N-M2P6 - 10-Link HUB, 16 I/O ,NPN, M12, IP67
ULK-0808N-M8P6 - 10-Link HUB, 8 1/0, NPN, M8, IP67

Web Page Password Box Elements: now include the Actions property.

Bugs fixed in this patch

IP Settings Edit HMI Widget: UniLogic would crash when 'IP Address Type' was set to CPU or DNS.
In certain cases, SQL queries crash, and 1/O Bus errors occur after a PLC upgrade, requiring system reboots.

Resolved an issue where the 8th input module on a Remote 10 URB-TCP was not read correctly and
sometimes showed incorrect high-state bits for modules 7 and above.

LF: Bits to Num: Bits in the resulting number were not reset properly.
Web Server denied access when a favicon was unintentionally used in the application.

RestManager authorization using a token from a tag failed, resulting in the tag not being registered and
returning an empty value.

HMI Rectangle: widgets with a black border were not displayed correctly. Additionally, white rectangles
were not visible on the screen.

The alarm banner appeared even when the Banner Type was set to 'Small'.

In certain cases, the 'FTP Put' command would fail silently when the command length exceeded 256
characters, showing a successful status despite not actually writing files to the FTP server.

When importing EDS files in UniLogic V 1.33 and beyond, input and output variables are incorrectly imported
as bit-type format instead of the expected INT format.

TCP server on US15 PLCs rejects new client connection attempts following client disconnection events.

Change Summaries for Previous Versions begin on the following page.
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UniLogic® V 1.40.71 UNISTREAM® OS 1.40.91 January, 2025

UniLogic 1.40.71 introduces performance enhancement: Improved download time. After the initial compilation,
subsequent downloads are now completed faster compared to previous versions. This upgrade reduces
development time and increases productivity.

This version supports the UAC: Audit feature to ensure compliance with FDA 21 CFR Part 11, supporting secure and
traceable record-keeping.

Improved Download Time |After the initial compilation, downloads are now completed faster compared to previous
versions. This upgrade reduces development time and increases productivity.

Note that:

e Older UniLogic versions (previous to 1.40.xx), will not be able to communicate with
controllers running firmware OS 1.40.xx and higher.

e Attempting to download to a controller running older firmware will raise a warning,
informing the user that the download cannot be completed until the firmware is
updated.

e If the PLCis running firmware version 1.40.xx or higher, UnilLogic versions earlier
than 1.40.xx will be unable to communicate with it. As a result, downgrading the
firmware using UniLogic 1.39.xx is not possible. In such cases, use a USB stick as
explained in the UnilLogic Help topic Firmware>How to Downgrade Firmware.

UAC: Audit The new Audit feature is especially needed for ensuring compliance with FDA 21 CFR Part
11, supporting secure and traceable record-keeping. This feature logs system events and
user actions across various elements, including:

e User Access control (UAC): Tracks login, logout, and authentication changes.
e Date & Time: Logs changes to date and time.

¢ VNC: Records remote connection and disconnection events.

e Alarms: Captures alarm acknowledgments and clear actions.

e Actions: Monitors global and local actions, such as tag modifications and bit
operations.

e HMI: Tracks interactions with elements like buttons, sliders, and data tables.

The feature also introduces a Global Action: Export Audit Trail, which generates digitally
signed CSV reports using user-defined separators. This ensures data integrity, traceability,
and compliance with regulatory requirements.

Project-level Actions Actions now include the ability to Load Last Screen.
Third-party Protocol New Ladder function for Build Message Indirect provides dynamic message selection.
Functions

11



MQTT

Subscription Configurations now support parsing nested JSON objects using the
new Complex JSON format, including the ability to capture entire JSON structures with
the BUFFER parameter.

HMI Editor Additions

e HMI Numeric Elements: now includes a Password Numeric Box

HMI Graphs/Meters: now includes a Dynamic Linear Gauge, enabling dynamic
changes to widget properties.

HMI Digital Date and Digital Time: now include additional format options

HMI Rectangle Elements: now include the Actions property

e HMI Numeric Box Elements: now include Linearization options

WE: Web Page Widgets

WE Text Elements: now support Password Box widgets.

WE Simple Elements: now includes an Ellipse element

Alarms

Alarms now support several new features:
e Global:
o Default Summary Sorting
o Suppress All Alarms
e Each Alarm now includes:
o Log To History - by unchecking this option, you decide which Alarm events
should not be recorded in the Alarm Log folder on the controller's SD card and
displayed in the Alarm History widget.

e New Alarm Ladder Elements:

o ACK/ACK & CLR Alarms

AOIl: Detect Color Ladder
Elements

Use the Detect Color from Image and Detect Color from Camera Ladder functions to enable
optional noise filtering and Region of Interest (ROI) settings, with LAB color space facilitating
precise color difference calculations using Delta E.

LF: SD File Functions

SNMP: You can now use the *.ini file to change the destination IP Address of an SNMP Trap.

LF: Toggle Bit

Use this Ladder function to toggle a specific bit's state within an array of bits whenever a
designated condition is met.

LF: Num to String

Use this Ladder function to convert a number into a formatted string.

LF: Buffer Tools

Use the Copy Buffer to Array and Copy Array part to Buffer Ladder functions to streamline
data handling by efficiently transferring information between buffers and arrays.

Reset UniLogic Connection

You can now reset the Server via UniApps> System> Control> Reset> Reset UnilLogic
Connection.

Message Composer

You can now configure a Checksum Only option in the Message Composer Group Properties,
enabling the use of a checksum without requiring an ETX character, enabling compatibility
with devices that use only a CRC16 checksum for message termination.
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Additional Features

Emails: the list of configurable elements in an email now includes Line Break Type, allowing you to
customize line-break formats for better compatibility across various systems and platforms when composing
emails in Outlook. Options available:

- LF: for Unix/Mac OS X systems

- CR: for Mac OS systems (pre-X)

- CRLF: for Windows

HMI & Web Server Rectangle Elements now enable you to adjust the Corner Radius.

Passwords: to ensure the password stored in the exported file is applied to the controller during application
import, select the new Overwrite Import/Export App password option under Project>Downloads>Export
project and firmware to a File>Passwords.

SPA Track: the Solar Position struct now includes 3 additional Output parameters: Sunrise Hour, Sunset Hour
and Hour Angle.

Save As Enhancement: the "Save As" function now defaults to the folder where the current project was
opened, rather than the last accessed folder.

CANopen: FunctionIN tags are now supported for the "F" ear (Input Buffer) and used in the SDO Download
function block.
Note that the SDO Upload function block remains limited to Global tags.

MODBUS: UniLogic now includes the ability to Import Slaves in the Protocols>MODBUS>Slaves section.

System > Panel Events Struct: a new read-only status bit, Screen Saver On, has been added. This bit indicates
when the system is in screen-saver mode.

Options > Localization: this version contains Korean language localization.

Touchprobe functionality is now available for the E3 servo drives.

Bugs Fixed in this version

Unnecessary pop-up messages appeared on every power-up when using a USB keyboard/mouse/HID device,
incorrectly indicating device malfunction.

When using the Divide function block on a UINT32 tag, the result is incorrect for values greater than
2,147,483,647, which is the midpoint of the UINT32 value range.

When activating the Hardware via Online mode with a working connection, a connection error message is
displayed even though the activation is successful.

DataTable HMI Widget: in a Read-Only Data Table widget, the "Enter Array On" button incorrectly appeared,
despite no array being defined and no editing being allowed.

Modbus: the SWAP Bytes operation is now restricted to appropriate data types.
CANopen: resolved a crash occurring in certain high-load CANopen drive applications.

Alarms:
- the change detection mechanism failed to identify changes to the 'Show suppressed alarms' property,
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incorrectly indicating no differences between the project and the PLC.
- the alarm banner reappeared in full size after using the snooze button and switching HMI pages.

UAC: failed HMI logins displayed an error but did not allow retry or cancellation.

LF: Shift and Rotate:

- Incorrect byte-based calculations caused Shift Left/Right function to return an Errno for lengths exceeding 8
bits. Bit arrays were unaffected.

- Rotate Right function always set the Carry bit to zero when used with bit arrays. Rotate Left function was
unaffected.

LF: Linearization: INT32 inputs failed to overflow correctly and produced inaccurate results for large
numbers.

Cyclic Live Trend: UniLogic would crash when a Cyclic Live Trend with curves is copied and pasted multiple
times on the HMI.

Redfish: when disabling Redfish and saving the project, the user could not re-open the project.

Message Composer: REAL numbers are missing when sending TCP messages via the server TX command on
the Built-in models.

"Data entry complete":

- tag of an HMI element Numeric Box did not trigger when a value of "0" was entered.

- bit for a Numeric Value Box (REAL number type) only triggered for non-integer inputs (e.g., 11.2) but not
for whole numbers (e.g., 11 or 11.00).

- Find in Array FB did not work when using an array for the data entry completed event in an HMI widget.

Capture Image: the "PeriodicTaskManager" would crash during project download/import if there was no
camera connected. This would prevent the camera from functioning until the system reboots.

REST API: assigning REST 'Response/Query Parameters' tags over 1024 bytes caused REST services to fail.

Quick Sync: when using the 'Sync' button to download tag changes, images and other elements would
disappear from the HMI.

EtherCAT:

- UniLogic would crash when importing the 'Keyence.xml' definition file from the EtherCAT Slaves Library.

- Initialization Status may return status 3, Topology Mismatch, after changing cyclic drive type.

- Updating the EtherCat module firmware must be done with a USB stick, max USB partition capacity: 16GB.

Online Mode: Local function tag values were not displayed in the grid during online Ladder function
monitoring.

Uni-I/O modules: I/0 bus error [Code 0] triggered, when connecting a UAG-CX-XKP module on the Built-in
US15 controller.

UniApps, Auto-Sync RTC: in certain cases, the Auto-Sync feature failed due to a malfunctioning worldtimeapi
API, causing the "Sync Now" button to become unresponsive and require a system reboot to update the
time.

VNC Server: in certain cases, due to reverse DNS lookups, VNC clients experienced a few seconds delay when
connecting to the UniStream VNC server.
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Custom Controls: in certain cases, using the increment action on a tag passed indirectly (e.g., via a Writable
Parameter) concatenated the value instead of increment it (e.g., 1 became 11). Direct writes were
unaffected.

Change Summaries for Previous Versions begin on the following page.
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UniLogic® V 1.39.103 UNISTREAM® OS 1. 38.55 December, 2024

Unilogic 1.39.103 introduces: Redfish-embedded PLCs. Natively supported by Built-in controllers only, the Redfish
RESTful interface APl enables UniStream to control data center cooling. This version also launches the new
UniStream US15-B10-B1, a powerful PLC + HMI with a big, quick-response 15.6” touchscreen, additional features and
bug fixes.

Redfish: Data Center |Redfish is a RESTful interface API based on a JSON data format, designed for data center
Cooling management.

New The new US15-B10-B1 PLC + HMI Built-in offers:
UniStream Built-in o . .
e Enhanced Performance: a significant boost in processing power.
US15-B10-B1
e Faster Real-Time Task Execution
e 15.6” Touchscreen HMI
e No Built-In I/Os—Create the configuration that exactly meets your requirements:
snap on Uni-10 to create an on-board configuration, and expand remotely with Uni-
10, Ethernet Remote 1/0, EtherCAT, and I0-Link modules.
e EtherCAT Compatibility: The US15-B10-B1 is the first UniStream Built-in model to
support our EtherCAT master module—and discrete, multi-axis EtherCAT motion.
Online Test Mode: e Alarms: you can now click an Alarm, and view all of its properties. Note that the
Increased properties are view-only.

Functionality e HMI Widgets: you can now click an HMI widget, and view all of its properties,

including any assigned Actions. Note that the properties are view-only.

AOIl: Get RGB Use this function for identifying the RGB (color distributions), in various objects.
Ladder Element

LF: SPA Track The Solar Position Algorithm (SPA) Ladder function enables UniStream to direct solar panels
at the sun all day long for maximum exposure.

LF: Modify Alarm Use this Ladder function to modify an Alarm’s description.
Property

LF: Digital Signature |This LF enables you to digitally sign SD generated user log files.
Sign

16



Additional Features

e |O-Link: in the Master's Properties window, you can now set the Pin2 Safe State.
e USB Action files can now be set to require a user password.

e LF: SD File Functions: You can now use the *.ini file to change the IP address of a URB Remote Ethernet I/O in
your project.

e User Access Control: In UAC properties, you can now select:
- Text input to cause the user to type in the user name.
- Drop down, to allow the user to select the user name from a list.

e OPCUA: You can now rearrange tags by hovering your cursor in the left column to reveal the hamburger
menu and dragging the tag to a new location.

e SD Management: You can now save captured images in the following SD card folders:
- “/SD/Media/Camera”
- “/SD/Media/Camera/AOl”

Bugs Fixed in this version

e PTO:
- PTO would crash when a move of one pulse was requested.
- In certain cases, requesting Immediate Stop would behave inconsistently.

e Calendar Date, HMI widget: selecting a Day of Week via the HMI did not update the Day of Week tag in the
RTC struct.

e VFD Write Raw Modbus: CPU would crash when using this Ladder Function.

e Telegram:
- when building a message, the user could not include read-only tags, the user can now include both read-
only and writable tags.
- within messages, UniLogic identified tags that were linked to parameters as 'unused tags'.
- UniLogic did not correctly include the values of string ASCII tags.

Change Summaries for Previous Versions begin on the following page.
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UniLogic® V 1.38.64 UNISTREAM® OS 1. 38.68 August, 2024

Service Pack 1 for UniLogic, 1.38.64
This Service Pack provides the fixes listed below.
Bugs fixed in this patch

e CPU OS 1.38.29 (included in BIN 1.32.68), caused the On-Board temperature input to return
incorrect values.

e BIN version 1.32.68 caused the screensaver to behave unexpectedly.
e Library import might fail due to Timer usage.

UniLogic, 1.38.62 supports a new series of Servo drives and Motors. The new B5 & E5-S* Servo Series
expands your Motion potential with a wider power range of up to 7.5kW (10 hp), common DC bus,
enhanced tuning, built-in STO (Safe Torque Off), TouchProbe functions supported by new PLCOpen MC
Function blocks, and more.

New Servos, Motors, MC Functions UMD-B5 and UMD-E5-S servo drives and motors
are now available in Hardware Configuration.
These models offer Touchprobe functionality,
supported by two new FBs:

e MC TouchProbe
Use this to record an axis position at a
trigger event. It records an axis position
at the point in time of a digital signal
(measuring probe function).

e MC AbortTrigger
This Function Block interrupts a
measuring probe cycle initiated by
MC_TouchProbe

Servos: Modulo Axes You can now define Modulo Axes for
both EtherCAT and CANopen
Cyclic 'Live' Trend Cyclic Trends enable you to display a specific

time frame of a running variable integer value,
for example, the last 10 seconds, as a curve on a
Trend graph.

The values are not drawn from a Data Sampler,
and Cyclic Trends do not store any values, log
any data, or create any files.

DataTable HMI Widget Data Table Properties of Appearance now provide
a new option, Scroll Bar Width.

Additional Functions

Enhanced security for Numeric Boxes in both HMI Elements (HE) and in the Web Page Editor. Use the
new 'Mask Entry' checkbox in UniLogic to enable this feature.

New Help Topics

e Shift-Rotate functions now have expanded Help topics.
e String functions and Array functions are now fully documented.
e The Schedule Ladder Function topic has been improved.
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Bugs Fixed in this version

UID-0808THS: Stop request during PTO acceleration or deceleration would cause the PTO to
freeze, THS OS 10.10.

UID-0808THS: PTO maximum speed was not updated according to units ratio, THS OS 10.10.

OnBoard I0: Overflow on 14-bit analog inputs in the OnBoard IO wasn't detected, depending on
production calibration. May impact RA28, TA30 and TA32.

ST Bitwise AND & OR operations are not functioning correctly.
UID-0808THS - Scenario 3 queue mode fails on frequencies 50KHz and higher.

"Data entry complete" tag of an HMI element Numeric Box sometimes changes in state is not
immediate.

Pressing Reset Display when using a USB keyboard/mouse/HID device, might cause the screen
to turn black.
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UniLogic® V 1.37.79 UNISTREAM® OS 1. 37.79 June, 2024

Service Pack 1 for UniLogic, 1.37.79 provides the fixes listed below.

Note: this version requires you to update your PLC firmware.

Bugs fixed in this patch

e Data Tables:
- Entering Online Mode when working with a Data Table would cause Online Mode to terminate
- Dragging (undocking) a Data Table would cause UniLogic to freeze, requiring the user to close
and reopen UnilLogic.

e Printing: when a project was printed to .pdf, the Structured Text functions were not included.
e Screen Saver: continued to run when turned off from UniApps.

e Camera Capture: width and height tags are optional; however no image would be captured if
these tags were left undefined.

e SD Management: selecting to clear the Camera folder did not remove AOI debug files.

e UCR Routers; name error: UCR Routers delivered after June 1st, 2024, require this version of
UniLogic (Service Pack 1 to 1.37.00) or later.

Also included in this release: MODBUS>Advanced Properties Window: Float Type has been renamed to
4-Byte Swap Type.

UniLogic, 1.37.00 supports a new series of Servo drives and Motors.

The new B5 & E5-S* Servo Series expands your Motion potential with a wider power range up to
7.5kW (10 hp), common DC bus, enhanced tuning, built-in STO (Safe Torque Off), TouchProbe
functions supported by new PLCOpen MC Function blocks, and more.

*E5-S EtherCAT drives are coming soon.

New Servos, UMD-B5* and UMD-E5-S servo drives and motors are now available in Hardware
Motors, MC Configuration. These models offer Touchprobe functionality, supported by two new
Functions FBs:

e MC TouchProbe
Use this to record an axis position at a trigger event. It records an axis
position at the point in time of a digital signal (measuring probe function).

e MC AbortTrigger
This Function Block interrupts a measuring probe cycle initiated by
MC_TouchProbe

*The current version of the diagnostic application does not support the B5 series

Servos: Modulo You can now define Modulo Axes for both EtherCAT and CANopen
Axes

DataTable e Data Table Properties of Appearance now provide a new option, Scroll Bar
HMI Widget Width.

e The HMI DataTable widget UAC configuration now offers Element
Restrictions, which offers an Invisible option; when enabled, the widget will
appear only to users who log in with the correct user level. Note that you
must enable User Access in order to reveal the Invisible option.
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UniApps e Open Menu: by default, to open UniApps, the end-user must touch and

maintain contact for several seconds with the upper right corner of the HMI
Panel touchscreen until the UniApps sidebar menu appears. You can now
change the location of the point of contact in Hardware
Configuration>Controller Model>Properties Window>UniApps Side by Side
menu.

e User Access Control: the interface has been improved; when adding users,
only the groups and users that are used in the project, and that have
assigned roles, are now shown.

Live Trend The number of curves for a single Live Trend graph has been raised from 4 to 8

UniCloud Data If you have a UniCloud subscription from Basic Data subscription or greater, you

Backup can backup data stored on your controller's SD to the cloud. The data is stored in
the cloud in a .zip file, and can be downloaded, or restored from UniCloud back to
the PLC.

USL Displays In UniApps, you can now connect via hosthame, as well as IP address, by

accessing UniApps Network>General IP/Hostname, and selecting Hosthame.

HMI Widgets Circular Gauge widgets now offer the option Whole Circle; selecting this option

results in the gauge numbers and ticks covering the entire 360 degrees of gauge.
Project-level Actions now include the ability to actviate and deactivate the Screen Saver
Actions

TextBox widget The numeric keyboard now offers commas and dots

Bugs Fixed in this version

Load Config from INI: when done from DOK, was not supported by the USC-B3 models.
REST_API: Minor changes might result in 'Download All with Reset' when it was not necessary.
BACnet: "Access Denied" error would result when trying to write to Binary Value.

Servo Ladder Functions: Loading a Servo configuration after Storing it would result in
Configuration Mismatch Error (-5 ).

UniApps Timzone: setting timezone from UniApps did not update the localtime file with the new
timezone link.

"Set value" HMI Action took excessesive time (~1s-2s).

Live Trend Widget, Web Server: "Curves" button did not work.

UniStream UAC: User names were case-sensitive, and allowed duplicate usernames.

Router INIT Ladder function would fail (-9 ) when there was no SIM card installed.

The option to change the Open UniApps side menu location was visible, but did not take effect.

C Functions:
-Global variable tag values did not change on nested C function calls
-If a Global tag was used in a FunctionOut call, the value did not update

Asset Type: UniLogic would crash after refreshing an Asset Type, if a Demo Asset Typewas
selected.

UAC struct: if a user was changed to different group via UniApps, the "comment" in the UAC
struct did not update the name of the changed group.

Load Certificate Status: the Error PopUp did not in the correct format.
THS: PTO Move would stop running after a period of time.

Call Function: the hyperlink to calling function was missing, if the called function was type C or
ST.

0808THS module: Counter+scenario 3 encoder A/B did not function properly.
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UniLogic® V 1.36.44 UNISTREAM® OS 1.36.44.xx March, 2024

This version of UniLogic supports the new B7 VFD series that supports EtherNet and provides closed-
loop control, a new analog I0-Link hub, the ULK-0808AIO-M2P6, Telegram messaging, and more.

VFD: VED B7 is the successor to the B5 series, bringing you motor control for torque,

New Series speed, and boosts safety with built-in STO. These expandable inverters offer advanced
motor control with features typically found in specialized drive solutions.
Optional: Ethernet communication, I/0, and closed-loop encoder cards.

I0-Link: New The new analog IO-Link hub, ULK-0808AI0-M2P6, provides 8 input/output channels
Analog Hub that can be set to either current or voltage.

Telegram UniStream controllers now support Telegram messaging via UCR router. Integrating
Telegram support into your machine can offer several advantages:

e Real-time monitoring and machine control via Telegram's fast messaging
service

e Automation: for example, in your UniLogic project, you can build a program
that sends alerts or reports about machine performance to a Telegram BOT.

e Security: Telegram messages are highly encrypted, which can aid in protecting
sensitive machine data.

e Multi-platform Access: Telegram allows you to access your chats from multiple
devices--from any location.

e Free of Charge: Since Telegram is free for unlimited use, it is a cost-effective
solution.

e Team communication: the ability to create groups or channels in Telegram can
aid in various ways, including support.

Additional Features

Change VNC You can now use a Ladder function block to change the VNC Server Password and
Password Management Level.

VFD: Read/Write New Ladder Elements, VFD Read Raw Modbus and VFD Write Raw Modbus enable you

Direct to directly read and write to a VFD.

HMI Element: A new property has been added, Preserve Margins. This is checked by default;
Slider uncheck if you wish to decrease the padding around the slider.

Bugs Fixed

e B1 VFD models: in certain cases where the rated voltage was changed, the configuration was
not saved.

e Digital Time HMI Element: behavior was Read-Only without regard to the actual setting.

e IO-Link:
-The IODD parser would incorrectly set the master's port configuration value.
-Adding 4 device IIOD's toone IO-Link master wouldcause compilation error.
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WebServer password protection: if protection was removed and project then saved and closed,
when reopened the webserver in the project would still be password-protected.

Application Download: after upgrading from BIN 1.32.112 to BIN 1.35.47, users could not
download a UniLogic application to the controller.

HMI Action - Set Value: if a HEX value was given, the specific action was not applied, and other
actions were ignored as well.

Servos: Drives would not recover communication after a power outage.
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UniLogic® Service Pack UNILOGIC® V 1.35. 227.92 UNISTREAM® 0S
1.34.47 December, 2023

This version of UniLogic, released in January 2024, provides security enhancements to protect
networked controllers from cybersecurity threats.

(Special thanks to Noam Moshe of Claroty Research - Team82.)

Note that the Equipment Level cybersecurity measures described in the Unitronics’
document hosted on our website, *Unitronics Cybersecurity for UniStream PLC Series’ are
now mandatory.

In addition, the Network Level protection measures described in that document, including
using a VPN to secure communications and protect equipment, are strongly
recommended. Implementing Network Level protection is the responsibility of the user.
This version of UniLogic requires you to change the default PLC communication password
and to implement complex password. In addition, this version requires you to implement
a VNC password.

Unitronics strongly recommends that users with existing applications comprising
networked UniStream controllers update to the current version.

Security Features

PLC Password As of this version, UniLogic requires you to change the default PLC
communication password, and requires you to assign a complex password the
first time you establish UniLogic to UniStream communications to a particular
PLC, for example at application download, or to run online Test mode.

The PLC password must be at least 8 characters long and must contain at
least 1 digit, lower case letter, and upper case letter, in addition to at least 1
symbol.

Once a password is assigned to the PLC, UniLogic stores that password for
that specific user (the user currently logged into Windows).

When any user attempts UniLogic to UniStream communications, UniLogic
authenticates the user access permission to that specific PLC.

VNC Password | As of this version, enabling VNC requires you to create a strong password. The
option to enable VNC without a password has been disabled.

Addtional Feature

2 VFDs via Relevant for Built-in and UniStream PLCs, not UniStream Modular.
RS485 You can now add 2 serial RS485 Add-on Ports to your hardware
configurations, and define the port of each to VFD.

Bugs Fixed

o I0-Link:

- RPI (Requested Packet Interval) was linked to the total number of linked devices, when should
be linked to the total humber of masters.

- IODD files were sometimes incorrectly parsed

o Modbus Slave IP: in certain cases, updating a slave IP manually or via TCP did not write
the new address to the Modbus slave.
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o VNC Client, UniApps: the cursor was visible when Disable Cursor was turned ON.

. AOI, compilation errors: in certain circumstances, AOI rectangle coordinates were not
assigned to the correct struct tags.

o UniLogic might shut down when a project was saved as 'Save As', reopened, and a
module (HMI. Ladder, Web) was added.

o Web-server:

- Copy&Paste of of Numeric Box and Timer Box into a web page would cause UnilLogic to shut
down at compliation.

- Numeric values were sometimes incorrectly displayed with thousands separators.

- Numeric box: configuring Language> Regional Settingsa to show a thousands separator would
show the separator in UniLogic, but the number would be displayed without the separator.

- Numeric box: values configured as normal text would appear as bold text.

- After editing, Web pages would sometimes appear with incorrectly-sized fonts, incorrect
background colors, and incorrectly-underlined values.

o Quick Sync mode, Online: a project is verified before entering Online mode. For this
reason, Quick Sync no longer reestablishes connection and re-verifies project.

o HMI Timer box: 'Text Before' would not be displayed if "Text After' was not configured as
well.

o Structured Text: using 'TO_ REAL' inside a FOR Loop would cause a compilation error.

o Set DTI Column Value inside a ForEach loop causes compilation error.

o Load Config from INI: did not allow a remote URL to be set for the FTP client.

o C functions: creating a C function, upgrading the UniLogic version, and adding additional
lines of code caused compilation errors.

o EDS files:Ethernet IP Structs with INT arrays did not load correctly in Unilogic 1.34.192.
o Changing COM port settings from UniApps: if the port was set to Modbus, the change did
not take effect.

o SFTP client: PLCs failed to send files via SFTP when the password contained an '
(apostrophe).
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UniLogic® Service Pack UNILOGIC® V 1.34.92 UNISTREAM® OS 1.34.78

October, 2023

The UnilLogic version, released in October 2023 brings you the features and bug fixes listed below. Powerful new
features include support for both 10 Link masters and devices, Structured text, AOI, the ability to open and run up to
3 instances of Unilogic, and more.

This UniLogic version, released in October brings you the features and bug fixes listed below.

Powerful new features include support for both IO Link masters and devices, Structured text, AOI, the
ability to open and run up to 3 instances of UniLogic, and more.

New Features

IO-Link

UniStream controllers now support IO Link.

All UniStream controllers support the new Unitronics IO0-Link Master products.
Specific models of masters and modules as well as cables are available from
Unitronics; these models are visible in UniLogic's Hardware Configuration.

In addition to the specific I0-Link modules offered by Unitronics, you can
include other I0-Link devices and import the device's IODD (IO Device
Description) that is supplied by the device manufacturer.

Structured Text

UniLogic now offers a Structured Text editor, along with library of functions
such as MAX MIN, LOG, EXP, Trig functions and more.

You can build Structured Text functions and use them in the same way you
use standard ladder or C functions. You can call them just like standard ladder
functions, reuse them, and export/import them via the Library. You can

also refer to Ladder functions.

Structured Text:

e Enables text-based development, that is compact and easy to read

e Is highly portable--and allows you to copy developed functions from
other brands

e Allows easy comparison and source control

AOI
(Automatic Optical
Inspection)

New Compare Image Ladder functions now enable you to compare:

o Images from a connected USB Camera to an image stored on the
controller's SD card

o Two images stored on the controller's SD card

You can select the algorithm family and specific algorithm that the function will
use to compare them. Algorithm families include:

o Pixel-wise Comparison

. Histogram Comparison

. Template matching

o Feature Detection and Matching

UniLogic: Multiple
Instances

You can now open and run up to three UniLogic projects at the same time to
compare them. You can also transport the following elements between them:
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o Drag & Drop, or copy & paste Ladder elements and rungs from one
open UniLogic project to another open project.

. Copy HMI/web page elements, including all of the elements on a
screen/page, from one open UniLogic project and paste it into to another open
project.

Note that UniLogic automatically creates tags and structs as needed.

MC Motion
Functions: Buffer
Mode

The parameter Buffer Mode has been added to the MC Function Blocks listed
below. Note that this mode is relevant only for Cyclic or Virtual Axis motion.

. MC GearlIn

. MC GearOut

) MC GearInPos

o MC CombineAxes
o MC MoveAbsolute
o MC MoveRelative
o MC CamlIn

o MC CombineAxes

Motion: Virtual
Axis

In Motion > Axis, you now have the option to add a virtual axis.

You can then use it as a virtual machine shaft, master axis, or any other
intermediate axis for complex relationships between master axes and slave
axes.

Camera Ladder

Camera ladder function Capture Image now includes Image Width and Image

Functions Height parameters.
You can use this feature to capture images of the correct dimensions for AOI.
UniCloud You can now use Asset Type as a template to:
o Allow the share of a defined Asset Type on equipment using
different types of hardware
o Reuse configured dashboards without the need for using Tag
Types
REST API XML response support:

o New Content Types: in addition to JSON, UniStream now also
supports xml, Text/Plain, and x-www-form-urlencoded support

o Requests: you can now select to accept JSON or XML for all request
types.

JSON Content Parameter Levels: these have been increased from 3 levels
to 5.

C: Online Mode and
Global Tags
Property

You can now:

. Enter OnLine Mode when viewing a C function and view the value of
individual tags, as well as view all of the struct member values.

o Include global tags in your C code, enabling you to use them via online
mode, without having to pass them as a parameter.
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Quick Sync

When in online mode, you can enter Quick Sync Mode then change logic and
tag assignment.

Router: Get/Set
IO0s

New ladder functions enable your to read from and write to the status of I/0s
on Unitronics B5 and B8 routers.

Rung comments

Double-clicking on the rail now allows you to add/open a rung comment.

Tag Groups

You now have the option to group global and timer tags. You can also right-
click a tag group and rename it; all tags in that group will be automatically
assigned to the new name.

UniApps in Spanish

The UniApps interface now supports Spanish; to display different languages in
the UniApps interface, select the desired language in Hardware Configuration>
Controller Model > Regional settings.

Alarms

There is now an option in Alarms Banner notifications to link a bit that turns on
when the end user presses the Snooze button.

LF: Load Config Ini

o MODBUS: You can now set ModbusTCP (IP Address,

Port) parameters in your application via the Load Config - .ini ladder
function.

o Load from DOK: Load Config .ini now allows you to load a file

from a DOK (USB stick) as well as from an SD card.

Ladder Elements:
Up Down

Located in the Ladder toolbox under Basic Elements, these_Ladder elements
pass on the RLO of a rung--without being linked to a tag:

o The Up element assigns TRUE to the output signal Out for one
cycle only when the input signal In changes to TRUE. Otherwise, the
value of Out is FALSE.

o The Down element assigns TRUE to the output signal Out for
one task period only when the input signal In changes to FALSE.
Otherwise, the value of Out is FALSE

PC-PLC Password

You can now change the PC-PLC communication password via UniApps>
System> PLC >System > PLC Password.

Project Password

You can now assign a password that will be requested by UniLogic whenever
anyone attempts to open the project.

WE: Web Page
Widgets

Additional Features

Web Pages now support Time and Date widgets; configure them the same as
you do HMI Time and Date widgets

. When the VNC client is attempting to re-establish communications, a popup timer is now
displayed, counting down the remaining time until retry.

o Modbus Slave IP addresses are now automatically updated when the IP address is
changed via UniApps, a Load.ini file, via USBF, or via DHCP.

. C Editor: the status bar at the bottom now indicates both the line and the column
location of the cursor.
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. HMI Timers: a new option in the Timer Box allows you to enter any text you wish to set
as a prefix to the numeral. You can also include special characters, such as a degree sign, by
clicking the button on the right of the Text Before field.

o HMI/Web Numeric Box: you can now add a prefix of text and special characters to
display in front of a numeric value.

. Arrays: you can now create arrays of up to 1024 elements.

. You can now export and import Switch Case instances.

o HMI Element File Selector: now includes an option to select the Camera Folder from the

controller's SD card.

Bugs fixed in this version

o Polish virtual keyboard: the 'Y' 'Z' keys location were transposed.

o Alarms: modifying alarms from CSV files did not properly update the Alarm Banner, and
sometimes caused Alarms to crash.

o 04PTN: in certain situations, Input 0 would freeze.

o Message Composer: did not work properly when numeric tag format setting in the

message is Leading Zeros

o Web Timer Box, Seconds format: value was not displayed correctly
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UniLogic® Service Pack UNILOGIC® V 1.33.373 UNISTREAM® OS 1.33.280

June, 2023

This UniLogic release, released in June 2023, includes firmware that supports a redesigned version of
some UNI-IO models and hardens the Cybersecurity of your applications.

Read on to learn the details, and to see the bug fixes included in this version.

New Features

Cybersecurity

This security release hardens the UniLogic to UniStream communication
mechanism, in order to reduce unauthorized access.

Note that:

e Older UniLogic versions (previous to 1.33.246), will not be able to
communicate with controllers running firmware OS 1.33.246 and higher.

e Attempting to download to a controller running older firmware will raise a
warning, informing the user that the download cannot be completed until the
firmware is updated.

e If, for some reason, a firmware downgrade is required, use a USB stick as
explained in the UniLogic Help topic Firmware>How to Downgrade Firmware.
You will not be able to downgrade via UniLogic ribbon >PLC> UniStream
Management -> Remote Upgrade

In general, for better cybersecurity, we recommend that you always use the
latest firmware.

Uni-I0:
Firmware
Update

The firmware included in this release supports all Uni-IO models, modules
bearing a label containing the following:

e Serial numbers with the characters US1 start from the 3™ position, for
example: XXUS1ZXXXXX

e Text warning "Unit requires Firmware (BIN) 1.33.246 and up "

Serial Number:
The characters US1Z appear from
the 3rd position

UNITRONICS

UIA-0402N SNEX
Inputs: 4 x DC 0-10V, 0-20mA, 4- :
Ana. In:4 x 0-10VDC,0-20mA,4-20mA 000000
Outputs' supply:24VDC

Ana. Out:2 x 0-10VDC,+/-10V,0-20mA,4-20mA0
Operation Temperature:-20 to +65 °C
Requnres Firmware (BIN) 1.33.246 or hlgher]

IND EOETTEA% @US
Class 1 Div 2 LISTED
Groups A,B,C,.D

Requirement

Timer Box widget

You can now use more than 10 digits in the Keyboard Title property of a Timer
Box widget.

New System Struct

A new System struct has been added, Regional Settings containing ASCII string
members for CSV Delimiter, Decimal Symbol, and Thousands separator. At
power-up, or when HMI language is changed, the controller will write the
current regional settings into the struct.
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Bugs fixed in this version
Modbus RTU v2.0 did not update the RS485 port struct with TX/RX counters.

Alarms group import did not preserve the exported alarm IDs.

Export of alarm group would fail.

Export screen in UniLogic would sometimes fail.

Exporting IO tags to Excel would create an empty table.

DataTable widget, Time format column, min and max limits were not applied.

Linear gauge: Anchor and Range did not work for negative values.

Radio button widget: did not work on web pages when Font size was applied.

REST API GET: did not support an authorization token with special characters.

UAC: Logged in users were sometimes logged out after download.

UniLogic® Service Pack V 1.33.xx UNISTREAM® OS 1.33.xx MAY, 2023

This UniLogic version, released in May 2023, brings you new features including new HART functions
,DHCP, Motion functionality, and more.

Read on to learn about the new features and bug fixes in this version.

New Features

HART New

Functions

Motion

Password-
Protect via
Solution
Explorer

DHCP

UniApps

New Ladder functions for Build and Parse HART commands simplify
implementing HART in your applications.

o EtherCAT Multi-Axis MC functions: a new Ladder element Get Cyclic
Mode Error Description enables you to load the ASCII description into the
linked ASCII string tag.

o Motion Status and error codes are now collected into a single topic for
easier troubleshooting.

o CAM Table Plot: Select a CAM recipe, and from the Recipe tab, select
Show CAM Table Plot, then use the Configuration tool to adjust the view.

You can now right-click additional items on the Solution Explorer to password-
protect many parts of your application, for example in Hardware Configuration,
Communication, Motion, and more. The next time the project is opened, the
password must be supplied before the item can be edited.

New options in PLC Communications> Panel IP and UniApps> Network> IP
Config> Panel DHCP now allows you to enable DHCP and, when DHCP is
selected, to override DNS server.

You can now:

o View Logs for events such as download, upgrade, powerup
in UniApps>System>System Logs> Customer Logs.

. Filter Wireshark communications.
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Languages,
Regional
Settings

HMI and Web
page Widgets

HMI
Screenshots

I/0 Module
UID-0808THS
Loops

Email: TLS

VNC

Actions

Alarms

USB serial
devices

o You can now see a connected EtherCAT firmware version and
upgrade it - even if the PLC does not contain an application

. Set a PLC Hostname.

Regional settings for each language are now available via Solution
Explorer> Languages.

o Radio buttons: You can now arrange radio buttons simply by
entering the number of columns in the widget parameters; UniLogic
automatically arranges the buttons in Columns.

o Data Table Widget now allows you to:
- Set colors for Odd and Even Rows.
- Set Font Size.

. File Selector: Camera files have now been added to the selection
list.

. Timers, Minimum/Maximum: you can now set limits for timers.

o Text Boxes: you can now align text boxes in 9 directions.

In the HMI Editor>HMI tab> Screenshots, you now have the option to export all
of the screens in your application at once as screenshots.

New Scenario 4, Counter, PWM, PTO enables you to command trapezoidal
motion at run time via the module struct.

A new Loop Data Block parameter, Is Busy, allows you to know the status of the
block.

When you configure an email account, a new column, TLS, in the account
options can be checked to support Transport Layer Security (TLS).

The number of VNC clients that can connect to a PLC has been raised from 8 to
16; if the connection is via UniCloud, the maximum number of connections is
limited to 8.

A new action, UAC Log out Request, enables logout as a result of ladder
condition.

o New LF: Get Alarm Name - use this Ladder element to get the
name and description of an Alarm, according to its index number.

o Alarm logs: Previously, the Is Alarm Created bit and the the Last
Alarm Log Zip Filename were only updated if Create Zip File was
checked. Now, these parameters are updated even if only XML/CSV files
are created.

UniStream can now support USB serial devices at a baud rate of 230400
bits/sec

Please note that you cannot use the Rename File on SD Ladder Function to rename a file that is
located in the Alarm Log folder. The Help topic has been amended to include this issue.

Bugs fixed in this version

32



. WebServer Widgets set to Min/Max linked to constant tags did not work

o Update Application Ladder element did not work with String tag as path

o SMS Receive from Router (UCR) was only 7 words long

o Tags: Could not type non-Latin characters in tag description when creating new tag,
however Ctrl+V could paste from external source

o REST: Requests with Hard-coded content parameters did not work

o Screen Saver configured to 'Power Off' mode on B10 Modular PLCs did not turn the
display completely off

o If "MoveSDFileToDOK" on Copy\Move File ladder element failed, the reason (-8 no
source file) was not displayed

o Changing COM port settings from UniApps did not have an effect if the port was set for
Modbus

o HMI Schedule widget did not work in Custom Control
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UniLogic® Service Pack V 1.33.xx UniStream® OS 1.33.xx, November 2022

REST API « UnilLogic now supports REST API GET, POST, PUT, DELETE queries and
the Authorization methods of No Authorization, Basic
Authorization, OAuth 1.0, OAuth 2.0, and Custom Authorization.

e Content: you can now add JSON members and content to your POST and
Put queries.

e You can now right-click a REST API request to duplicate it.

usL You can now apply a password via UniApps that will be saved to the PLC via

Password the new System> Password tab.

Export BOM You can now generate a BOM (Bill Of Materials) report that matches the
Hardware Configuration of your project by selecting the Tool tab on the
ribbon and clicking Export Project's BOM.

UniApps: Update App and firmware now allows users to scroll though and select

Update desired files.

VNC Server UniStream VNC server "Set Touch Bit" is now checked as default value; this
allows the screen saver to recover from VNC.

External The interface for entering Numeric values and Text has been improved for

Keyboard external keyboards connected to UniStream.

HMI Disable Via UniApps, users can now choose to ignore specific popup messages by
popups selecting this on the System Log tab, and selecting the desired popup to
disable.

Please note that you cannot use the Rename File on SD Ladder Function to rename a file that
is located in the Alarm Log folder. The Help topic has been amended to include this issue.

Bugs

o If the SD card was not found, the system would issue an I/O bus error although there would be
no I/O error.
e In certain cases, the Router status was set to Fail inappropriately.

e Compilation warnings were issued for Alarms when one was not used in the application
e "Screen Power Off* mode on USP-070-B08 did not power off display as expected.

e UniLogic would crashes at compilation after a copy-paste call of a function with a Function-In
parameter

e In certain applications, HMI screens could not be exported.

e In some cases, certain elements on Custom Controls did not work, or prevented HMI screens to
load.

¢ HMI message boxes sometimes blocked HMI actions and buttons.

e Pasted ladder elements with constant inputs would appear invalid.

e Older applications using REST API, did not open with UniLogic 1.33.213
e Images and video from USB camera were not captured.

e Modbus: Success counter of Read operations would continue to increment after slave was
disconnected.
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e Trends, Web:"History" button on web pages did not work.
e UnilLogic did not Download & Reset after REST configuration changes.
e Alarm Logs: the Is Alarm Log created was not set to ON if zip files were not selected.

UniLogic® Service Pack V 1.33.xx UniStream® O0S 1.33.xx, September 2022
Major Features

EtherCAT Motion: When you use an Unitronics EtherCAT master module and configure

Multi-Axes functions the axes Mode to Cyclic, the master acts as a motion controller,
generating the motion profile and controlling the drives to enable you
to implement Multi-Axes functions such as Camming and Gearing.

UniLogic UniLogic versions previous to 1.33 were based on SQL 2012 LocalDB,

Infrastructure which reached end-of-life and is no longer supported by Microsoft;
therefore Microsoft will not patch possible security vulnerabilities in
SQL 2012.

After you install this UniLogic version, all projects of any version that
are opened and saved on this PC will be automatically structured to
SQL 2019 LocalDB.

EV Charger (OCPP) New Ladder elements now support and enable you to implement

Support Electrical Vehicle Chargers Protocol (OCPP v1.6), the protocol is
available only for UniStream Pro (B10/C10) series models and
requires a license.

Loops UniLogic now supports the following types of Ladder Logic Loops: For,
For Each, and While. Users can manage the number of iterations per
scan.

Update UniStream You can now update UniStream firmware and the UnilLogic

Firmware and application via both UniApps and Ladder functions. The files may be

Application located on either an SD card or an USB DOK stick.

Camera: Capture New ladder elements allow you to capture images and video from a
USB Camera

Screen Saver Mode Screen Saver is a new option in Hardware Configuration>Controller

Model>Properties>Screen Saver. When you check this, it enables the
UniApps Screen Saver mode. Via UniApps, you can then activate
Screen Saver to enable its options: you can power off the screen, and
enable recovery via VNC.

You can also set Wait time from last touch, when this timeout elapses,
the screen will turn black. You can also control brightness to save

power.
MODBUS MODBUS has improved functionality, and supports new options:
Improvements, New .

Options e Modbus>Add New Operation now offers an Add New Batch

Operation option.
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HART: New Features

Serial communication

over USB: USB to
RS485

Additional Features

Protect Application
Intellectual
Property

System Error struct

System Events Log

Data Sampler

Alarms
Application
Signature

Email

SD/DOK Status
Notifications

Ethernet IP EDS

VFD

High Priority Ladder
Task

SMS

¢ Floating point MODBUS registers can be swapped automatically
during read or write operations.

¢ MODBUS RS485: when there are multiple slaves, and some of
these are disconnected, the system performance is improved.

This version provides new HART Ladder elements: HART Command
Builder, and HART Response Parser.

UniStream Built-in & UniStream PLCs now support specific HID USB to
RS485 adapters, from Silicon Labs/DTECH and FTDI.

You can now include a specific UniStream's serial number in a Exported
Project File. Attempting to install the file to a different controller
using Update Application ladder functions will give error -9

Use the System Error struct to troubleshoot errors.

A log on the SD card located at SystemLogs/UniStream.log records
major events such as download, upgrade, powerup, and more

e The Data Sampler properties window now offers a new option,
Sign Files. Check this to create a signature for your BIN/.csv files.

e The Data Sample struct now enables you to set a Delimiter
character to be used in the CSV file

In Alarms general properties, you now have the option to create .xml,
.csv, and .zip Alarm logs and sign them.

Via UniApps>System> UniLogic App, you can now view the App
Signature in addition to the application name and version.

e Composer: you can now include a string variable in email
messages.

e Send email Timeout: You can new set a Timeout

e A new status message has been added to the email struct: -
10 unable to get local issuer certificate' when sending an email

When the SD/DOK is locked, or almost full, the system error struct is
updated.

EDS tags now include descriptions
VFD Run Frequency - the Frequency parameter is now an optional
setting. When frequency is not set, the current set frequency will be

used.

High Priority Ladder Task now offers new Ladder elements: Reset
counter + Reverse Counter

You can now add more than one contact in the SMS address list.
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User Files

LF: Copy/Move
folder to DOK

UCR Router

CSV and XML filenames inside a .zip attachment will now include the
timestamp

A new FILE>Copy/Move folder to DOK ladder function allows you to
move folders to a USB DOK.

New members have been added to the UCR Router Struct

for Daily/weekly/monthly data usage counters

UCR Incoming caller ID identification has been added.

Minor Features

Bugs

Structs: You can now right-click a Struct to duplicate it and edit its members.

OPC-UA: You can now:

Import an OPC-UA file from the SD Card, not only from a DOK flash drive.

Set the OPC-UA namespace from UniLogic in the OPC-UA Settings

URB: Allow to duplicate URB coupler structure and configurations.

HMI and Web page element Actions now enable you to Reset a Numeric Value.

UniApps: you can now import and export application configuration parameters from and to a
DOK flash drive, such as FTP, email, modem, SMS configurations and more.

UniApps clock, auto-sync: if you select auto-sync is ON, an attempt to sync the clock will now
be made every 12 hours, in addition to every action that requires HMI reset, such as reboot,
and download.

Keyboard: would show Cyrillic-Serbian instead of Serbian-Latin
Data Sampler: CSV+Zip would not be saved to history on power-up.
Online Mode:
o did not disconnect when updating the application from a ladder
o when using constants, incorrect tooltips were displayed
SQL DT->SQL: would fail when DT "From Row" was above INT16
UniLogic C Function: When referred to a struct, wrong comments were added
UniCloud: Creating an Asset on the PLC causes HMI Overload on some scenarios
USBF action: Change Password was not working
Servo:
o Servo Homing Method - Positive and Negative velocity were greyed out
o Importing a motion application could cause the UniLogic to crash
HMI: HMI Overload occurred after reboot when Start/End Sampling bit was on at start-up
Router Success bit and Signal Quality did not update when there was no connection
UniApps->Network->Serial: only the first serial port was available
VNC: Connection count and Connected Bit did not update after disconnecting
BACNet:
o I/O properties were not saved
o Server IP did not refresh automatically
OPC-UA: Will not require reset on every download
Remote upgrade was not cancelled after the connection was made to PLC

UniLogic, PC-PLC Communication: when download port 22 was incorrectly configured, UniLogic
approved PC-PLC Communication with a green checkmark and provided inaccurate
communication error messages

Email:
o Mail Configurator Widget did not add recipients to email
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o Sending an email with multiple TO/CC/BCC would fail if the 1st address was an empty
string
o Send email from UniApps - always sent from the first account
SFTP Client: would fail due to Failure establishing SSH session
MQTT: Wildcards having 'A/B/+/+/C' did not work correctly
CANopen:
o Did not send 2 SDOs in a row

o A sequence of "Init Node EDS" ladder functions being executed one after another could
cause a CPU error

o CANopen Auto-Start could cause a CPU errors
UniCAN:
o Incoming messages were lost

o After CANBus Disconnection, there's no need to reset PLC to re-establish the
communication

Modbus Master on USB port would sometimes stop working

Alarms: suppressing Alarm with ID higher than 255 did not work, and would suppress the
wrong Alarm

CSV: Convert CSV to UDTF failed after download
I/0:
o UIA-0402 outputs did not work properly

UIS-08TC did not show temperature when "Noise Rejection" set to 10 Hz. Other values
worked properly.

UniLogic® Service Pack V 1.32.xx UniStream® OS 1.32.xx, January 2021

Ths service pack brings you the features and bug fixes listed below.

VNC Server e 'Portrait Mode', UniStream PLC and UniStream Built-in: Portrait Rotation is
Management set to 90% by default.

e VNC Server Management has been moved from Passwords to its own
location on the Solution Explorer tree, directly under PLC Communications.

e The VNC Server Password is now in this section, and not in Passwords.

SD e Note that the option 'Is Rule Enabled' is now checked by default for all
Management file types for all projects. In addition, updating an older project will check
the option for all file types.
¢ SD management has been moved up the Solution Explorer tree to a new
location, directly under Hardware Configuration.
TCP/UDP CPU communications: a project that uses TCP or UDP Tx functions must also
Socket contain an Rx function. UniLogic now issues a compilation error if Rx functions
are not included in the project.
SMS You can now include up to 10 numbers in the SMS number list.
VNC The System>General tag Number of VNC Connections will be initialized when

the system recognizes that the Ethernet cable is disconnected, turning the
System>General tag bit Ethernet Port Link OFF for the port.

New Help Topic UniLogic provides ERRNO - Error Codes that report and retrieve errors for
ERRNO Ladder functions.
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Under System > Ladder ERRNO, you can find tags for the Function Index and
Error Number.

Bugs fixed in this version

UniLogic

Animated .gifs: previously, in cases where a display contained more than one language,
UniLogic did not check the number of animated .gifs per screen; the limit per screen is 4.
UniLogic now issues a compilation error for all displays containing more than 4 animated gifs.

CANopen EDS files containing space characters would fail to load; UniLogic now compensates
for spaces.

Router struct name can now be edited after re-opening a project.

UniStream PLC: setting/changing passwords via USB did not always work properly.

Data Sampler: CSV+Zip was not saved to history on power-up.

Remote upgrade: the user could not cancel remote upgrade after the PLC was connected.

Unnecessary compilation error was given when the last I/O module was removed from the
configuration.

Find in Array Back ladder function could not search for a bit data type.
Mail Configurator Widget failed to add recipients to emails.

UniStream

Alarms: selecting an Alarm ID higher than 255 would result in the wrong Alarms being
suppressed.

Disconnecting/Reconnecting I/O might cause a CPU Error.
Ethernet/IP counters: values were not stored.

UniApps, RTC auto-sync: would stop working after 24 hour. Now, when auto-sync is on, the
controller will attempt to synchronize the RTC every 12 hours, and at every PLC reset.

CANopen:checking the Autostart option would cause CPU errors.

UniLogic® Service Pack V 1.32.xx UniStream® OS 1.32.xx, December 2021

Features
HMI: Use Reset Numeric to enables your users to reset a value via the HMI.
New Action
Find e Finding 'Todo': searching for ToDo now includes Region Comments.

e You can now also search for text in Comments
e The Find Results pane now maintains a history of up to 15 searches.
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LF: Struct to/ These functions now work within UDFBs, as 'Function In' elements.
from Buffer

Message You can now right-click Devices and Messages and export/import them between
Composer applications.
BACnet IP Via UniApps, the user can:

e Enable/Disable BACnet
e Set Object ID from UniApps

Ethernet/IP When exporting an EDS file that contains ASCII strings, a message now appears

to recommend that the user convert the string using the Tag to Buffer Ladder
function, thus enabling the strings to be exported.
e The list of elements that you can include in an email now includes String

email Variable.
¢ email Recipients: Strings can now display recipient addresses.
e If the 'From' field has been left blank, a compilation message now
appears.
Alarms Alarm widget: ‘Severity’ columns can now be translated
OPC_UA You can now Export/Import Address Space.
MODBUS Now, as you add/delete each Modbus operation, UniLogic increments/decrements
their number.
UniApps, VNC UniApps>Networks> VNC Server now displays a list of up to 8
Server connections. When the list exceeds 8, the controller automatically disconnects.
FTP/SFTP Cases where the programmer uses illegal characters in creating a password now
Passwords display a warning, and also gives a compilation error.

Bugs fixed in this version
UniLogic

Motion:
- In certain situations, compilation would fail due to the Drive struct
- Adding the Servo and VFD diagnostic applications caused a compilation error

Tag Import: duplicating a tag name that was used as an alias would crash UnilLogic
DOK: in certain cases, updating the DOK would crash UniLogic
XY Trend: background was not transparent when selected

UniStream keypads: if two keypads were opened on screen, the first remained onscreen, but
was not responsive

'Load config from INI': DNS settings were not always supported

HMI, .gifs per screen: a message now appears to warn the user if the number of gifs exceeds
the recommended level.

Functions called via Switch Case: would be mistakenly given a compilation warning.

UniStream model, webserver: if the PLC model was changed from one that supported
webserver to a model that did not, the user would be warned that webpages woud be deleted--
even if the project did not contain a web server configurayion.

UniStream

Downloading a blank application (download + Reset) might cause a CPU Error
BACnet Server IP - Binary Value/Input object did not allow writes
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¢ VNC Server:
- after downloading certain projects, VNC server did not allow connection

o - when VNC server resolution was changed in UniApps, the resolution was not retained after
reboot

e SMS: If a phone number was not set, Sending SMS via Router provided an incorrect error (
SMS_ROUTER_GENERAL_ERROR = -7) when the correct error was SMS_TEL_NUM_ERROR = -3

(
e VFDs: :
-writing configuration files to 2 VFDs resulted in a CPU error
. -VFD is Connected bit sometimes rose to True too early, before the authentication process had

been completed.

e IO module (UID-W1616R) power LED blinked in certain cases where Message Composer was
included in the project

e UniStream Built-in - in cases of Boot error, a 'check physical connection' was incorrectly
displayed; this has now been replaced with a 'Contact Support' message.

¢ Mail Configurator Widget: selecting To/Cc/Bcc resulted in 'HMI Application Overload'
e FTP client: failed to connect when the $ symbol was used in the password
e Rest API: Send Value requests sometimes resulted in outdated values being sent

UniLogic® V 1.32.00 UniStream® 0S 1.32.00

Features

VFD: Ready-made VFD UniLogic's Ready-made VFD Motion code enables you to get moving

Motion code immediately—and does most of the work for you.. The application
includes both Ladder & HMI screens to enable you to run Diagnostics.
You can also edit it to suit your application.
You simply import the code, call it into your application, download it—
and start moving.

HE: VFD Drive Selector Place this widget on an HMI screen to enable the end user to select a

Widget VFD drive via the UniStream panel.

Data Tables LF: DTI to File
You can now select to retain formatted files: .csv .udtf, and csv.zip
files.

UniCloud: GPS Router ***Note that this feature is not yet supported in UniCloud, but will be

Support (s included in a future version.When you created a UniCloud Asset type,

you can enable Router Settings> Use GPS Location.

If your UCR Router supports GPS, this will cause the Asset location to
be harvested along with all of the other Asset data.

Bugs fixed in this version

e DOK: Safely removing a DOK (USB memory stick) would cause an incorrect message to be
displayed.

e FEthernet/IP EDS:
o ¢ EDS Import functioned improperly in certain cases of tag conversion and Assembly arrays.
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o *1/0 struct names would appear editable upon reopening project.
o e Short string import might cause an error

e Log upload: in certain cases, passwords were not correctly validated.

e Alarm History Widget: was empty after re-boot.

UniLogic® V 1.31.177 UniStream® OS 1.31.69

Features
Store DTI to file As of this version, the defined decimal format is retained for .csv files.
Export Data Table to File Array member names are now visible
Languages This version contains Polish language additions
MQTT As of this version, MQTT subscriptions ending with '+' are supported.

Bugs fixed in this version
e VNC: the value in Number of Connections was reset after a disconnection.
e UIS 04PTN: incorrect values were shown

e VFD Configurations: attempting to write configuration values to multiple VFDs might cause a
CPU error

e Data Tables, UniLogic: when defining Data Tables in Web server, the text 'Undefined' was
displayed instead of the actual value.

e EtherCAT: Adding a new PDO would sometimes cause UnilLogic to crash

UniLogic® V 1.31.70 UniStream® O0S 1.31.60, June 2021

UniCloud, This version supports new UniCloud widgets Switch and Update Asset.
New Feature Note that in order to use them you must update your UniStream OS, included
Support with this version of UniLogic; in addition, note that the tags in the Asset type
must be set to Read/Write.
For full details regarding UniCloud updates, log into UniCloud.io and open the
Help menu. Version changes are listed in the Welcome topic
UniApps: You can now sync your PLC's RTC with the current time for your time zone with
Auto-Sync the server at https://worldtimeapi.org/timezones. A new option, Auto-Sync,
RTC enables a PLC with an internet connection to remain synchronized with the
server, and automatically change to/from Standard to Daylight Savings time.
New Ladder The new Ladder element Read Line from File enables you to this to read a line
Element from a file on the SD card into a buffer.
Controller System Popup screens for HMI Overload now provide instructions to the user
Popup
Messages
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XY Trends In XY Trends Curves, you can now set the Y-axis to REAL, using up to 6 decimal
places.

CSV Decimals In CSV files, REAL numbers can now show values including up to 6 decimal
places

Bugs fixed in this version

e Ethernet: changing serial remote slaves ID via UniApps caused the remote slaves list to be empty

e« MQTT:
- After broker reconnection, subscriptions did not work properly
- Certificate import sometimes caused brokers to be automatically created
- HMI Overload screen would be displayed, when MQTT auto-connected to broker and Connection
interval is 0

e REST API Queries: INT16 and INT8 could not be used in query parameters

e REST API Requests: using tag parameters after hard-coded parameters did not work properly

e DT columns, HMI widget: column headers did not display properly after scrolling left and right

e Ladder comments: could not be opened if comment height was insufficient

e Download: in certain circumstances, projects would crash when compiling a project for download
¢ Keyboards connected to UniStream via USB port did not recognize certain characters

e UniApps:
- Serial configuration could not be edited.
- VNC: after changing the VNC server resolution from UniApps and rebooting, the resolution was
not retained

e Alarms:
- Banner, 15" UniStream: Text frame was incorrectly sized, when using "by Highest Severity"
banner color mode.
- Alarms occasionally crashed in certain situations.

e email: in certain cases, the 'fail' indication was set to ON, even though the email was successfully
sent.

e UnilLogic Hardware Configuration:
- a popup for I/O UID-0808T upgrade would be displayed, even when the UID-0808T was not
included in Hardware Configuration
- Compilation error: in certain circumstances, a compilation error was shown if UAG-CX-XKPLXXXX
was included in Hardware Configuration

e Router: When the router is disconnected from the controller, the Router Success bit and Signal
Quality value remained unchanged.

UniLogic® V 1.31.146 UniStream® 0S 1.31.122, March 2021

Features

REST API REST API now supports:

e HTTPS Servers.
e The Buffer data type, in the Response parameters.

MQTT Broker Connections now support MQTT/SSL -- Google Cloud IoT
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UniApps e MODBUS: in UniApps, under Network> MODbus, you can now access Ethernet

Master and Slave with an ID#=0.

e HMI Reset: in cases where the HMI application requires reset, the re-designed
message screen now instructs you to extract the system log to USB or PC, so
that you can send it to Unitronics Support.

Alarms e Show Suppressed State in Alarm Summary and History: if, in the Alarms global

Properties, you check the option Show Suppressed Alarms, 'Suppress' will be
displayed in the Value column for suppressed Alarms.
e German: Alarms Status, History, and Summary may now be viewed in German

Project The signature log has been expanded to include: import of Ladder, HMI, Web,
Signatures Message Composer, Formula, Import Data Sampler, Remote Modbus Slave, and

Alarms, as well as converting HMI displays to Web pages

Bugs fixed in this version

PLC communication password: In certain cases, UniLogic requested a password when no
password was required.

REST API: in some cases, slashes at the end of End Point Resource were ignored.

Alarms:

-Version 1.31.125: names were not preserved at import.

-If a user cancelled Alarms Export, UniLogic showed an 'Alarm Export Failed' message.

- Alarm headers occasionally aligned incorrectly

-In certain circumstances, icons did not display at 1024x600 resolution

Ethernet/IP:

-In certain cases, importing an Ethernet/IP EDS file containing bit arrays caused errors.

-In certain cases, an Ethernet/IP EDS file exported with minor Errors (set Run Idle bit).
-Commas used in parameters names were incorrectly read as delimiters.

HMI Editor, Panel Orientation:

-Changing models sometimes affected panel orientation (landscape/portrait)-When the project
was based on UniStream PLC (USC) models, changing the panel orientation sent the UniLogic
window backwards.

-In portrait mode, the Title of the Alarm History widget overlapped the CLR button.

Structs:

-Minor errors sometimes occurred in autocomplete.

-Adding a Description with two lines caused a compilation error.

In Hardware Configuration, the URB module URA-0008Y was shown as AOO8W.

WebServer: occasionally projects including webserver showed an error after download.
Including the character " \" in the Caption in the Properties window of an HMI or Web Data
Table caused an "Error while reading data", and in certain may have caused a CPU error.
Remote upgrade: changing to another IP without refreshing before beginning the upgrade
would cause the window to close.

In certain cases the controller required HMI reset; in most cases, the controller will now recover
without user intervention.

URB modules were sometimes missing from Function In after re-opening project

OPC-UA: operands sometimes did not update correctly.

BACnet: operands sometimes did not update correctly.

Alarm headers occasionally aligned incorrectly.

UniCloud: Sync Asset Type with UniLogic automatically created structs
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UniLogic® V 1.31.116 UniStream® O0S 1.31.94

This is a Service Pack for version UniLogic 1.31 Rev106 and UniStream 0S1.31.81
released in January 2021.
Features

e UniStream 'Cloud' controllers: All 'C' series model numbers are now available in Hardware
Configuration. UniStream 'Cloud' controllers are an industry first: a PLC with built-in, no-cost cloud services.
Each UniStream Cloud PLC is supplied with a pre-paid 5-year Start-up Subscription plan-there is no monthly
subscription fee.

e You can now export the error and status messages generated in UniLogic, via new Export to Excel tab in the
Error window.

e New Baud Rate added to CANbus: 100Kbit/s
Bugs fixed in this version
e EthernetlP: could sometimes not upload an EDS file.
e Modbus TCP: did not support Unit ID 0.
e OPC UA: would sometimes duplicate Tag names.
e Application import did not work in certain circumstances.
e In certain cases, older applications did not open.

e Emails: in certain circumstances, the controller did not send emails.
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UNILOGIC® V 1.31.106 UNISTREAM® 0OS 1.31.81

Unitronics first 2021 Release supports EtherCAT, the industrial fieldbus protocol that drives powerfully
precise processes in factories across the globe, is now easily implemented by UniStream® PLC* series.

Our new EtherCAT Master module enables you to integrate:

e Unitronics EtherCAT Servo_Drives
When you use a Unitronics drive, EtherCAT data exchange is transparent. You can implement
motion using UniLogic's Motion function blocks. A single UniStream can support up to 8 drives.
Plus, you can easily adapt any Motion application based on CANopen to EtherCAT simply by
making a few changes in Hardware Configuration

e Unitronics URB EtherCAT adapter
Via an EtherCAT URB adapter, you can communicate with Unitronics URB Ethernet-based I/0

modules

e Third-party EtherCAT slave devices
You can import a device's definition file, and exchange data via Ladder using SDO requests.

A single UniStream can support one EtherCAT master module, which can support a total of 32
EtherCAT nodes. This includes EtherCAT Servo drives, Remote URB adapters, and third-party EtherCAT

devices.

*EtherCAT is currently supported by USC-B5 and USC-B10 only.

Features

EtherCAT Master
Module

*Required for ALL
EtherCAT communication

Servo Motion
via EtherCAT

URB EtherCAT
Adapters

Third-party
EtherCAT

URB TCP
Adapter LFs

UniCloud

Export Project File

Additional Features

Hardware Configuration now offers a new EtherCAT Master
Communication module, the UAC-01EC2.

This new COM master module enables you to base Motion applications on
EtherCAT, to use Unitronics' URB I/0 via EtherCAT, and to include third-
party EtherCAT device in your applications.

You can now use Unitronics new EtherCAT Master module in conjunction
with Unitronics new UMD-E3 EtherCAT servo drives to easily build Servo
Motion applications.

All of UniLogics' PLCopen-compliant MC Function Blocks are supported
over EtherCAT as well as Ready-Made Motion code.

Hardware Configuration now offers the URB-EC1 EtherCAT adapter, which
can support up to 16 URB I/O modules per adapter.

You can import the ESI file of a third-party EtherCAT device and include it
in your application, communicating data via EtherCAT SDO Read and
Write Ladder functions.

New Ladder Elements enable you to reset, and to set the timeout of, a
URB TCP module.

This release is the first to support UniCloud, a complete, no-code IIoT
Cloud Platform specifically designed for the OEM and Machine Builder.

You can export a complete project to a local or external drive, and then
import/upgrade the exported Project File into any number of PLCs as a
new project, or use it to update an existing base project. You can import
a project file via UniApps, or via a new Ladder function, Update
Application.
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Alarms

OPC UA

Ethernet
Favorites

Ladder
Rungs &
Comments

Data Tables

Buffers

XY Trends

Ladder: Find
element via
F12

Toolbox

Ladder

Trends, Curve
Width

e Banner Color Mode: a new property in the Alarm Property Window enables
you to assign an Alarm banner color according to the highest (severity)
active alarm level, instead of a fixed color.

e Alarms Struct: new tags enable you to keep track of the count of the
number of alarms in the Alarm History and Alarm Summary.

e Alarm History Widget, Clear Button: in the widget properties, the new
Show Clear Button enables you to display a CLR button that can be pressed
by the user to clear the Alarm history.

You can now set tags to read /Write or to Read only in the Address Space
window; under Access Levels.

These can now be saved within your project.

You can now drag the borders and resize them.

e A new parameter, Digitally Sign file, in the Ladder function Store DTI to file
enables you to assign a Data Tag to determine whether or not to digitally
sign the file: 0 = Don't sign 1 = Sign

e Improved Array appearance

e The functions Tag to Buffer and Buffer to now support a BIT array tag type.

e Buffers now support Load from Array and Store in Array.

View Data Values: Your users can now touch the curve and view the sampling
value & time while an XY Trend view is in Stop mode. Touch View Data, then
touch the active curve to display two yellow lines that intersect at the touch
point. Use the arrows to move the point along the curve.

If you select one of the following elements in the Ladder, you can press F12 to
find all instances.

e Call function ladder element
e Switch case ladder element
e Jump to region

e Formula

e Send SMS

e Receive SMS

e Send mail

e SQL elements

You can now search for toolbox elements while in online mode

Right-click any Ladder element and select Pin to Bottom Bar to add it to the
Ladder element bar at the bottom of the Ladder Editor

During runtime, the Trend represented on the panel now offers a button that
the user can press to toggle the width of the curve line.
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Bugs fixed in this version

EthernetIP Node Struct: when adding a Scanner node using an EDS file, the new 'Config' tag did
not appear hyperlinked

Importing tags from Excel did not always function correctly.

Application Download: in certain cases, users could not download applications, in version 1.30
WebServer: Press /Release button function did not work as expected on mobile device browser
BACNet server: appeared to be in Init status, although it was running

Modem Signal Quality: if a Modem and a Router were in the same application, the signal quality
was reported incorrectly

Trends: in certain circumstances, using the Time Span option caused the system added an 02
before the actual time in X axis

UAC Account would sometimes lock in certain circumstances after downloading an application
XY Trend: a user needed to Stop the Trend in order to switch to the next curve

Ping Ladder element Time out did not take effect, affect when pinging from the CPU

UAC Idle timeout did not work from VNC

A Compilation Error would appear at download if the file name in Write VFD Parameters was
changed

Alarm History Widget: would stop presenting new data after approximately 10 days
Network Error sensitivity improved
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UNILOGIC® V 1.30.62 UNISTREAM® OS 1.30.51

This is a Service Pack for version UniLogic 1.30 Rev62 and UniStream 0S1.30.51 released
in December 2020

Bug Fixes

These bugs are fixed in this service pack:

e In certain cases, UniStream PLCs (USC series) could not boot up due to SD card installation
errors.

e UnilLogic HMI Editor: the HMI Element Properties window loaded slowly when moving between
elements.

UNILOGIC® V 1.30.58 UNISTREAM® OS 1.30.43, September 2020

This is a Service Pack for version UniLogic 1.30 Rev52 and UniStream 0S1.30.31 released
in September 2020

Bug Fixes

These bugs are fixed in this service pack:
e PTO sometimes functioned incorrectly
e VNC Server:

- Using a direct contact element for the "General.VNC Touched Bit" would cause a compilation
error

- Checking the "App resolution" checkbox would cause the "With cursor" and "Set 'Touch bit™
checkboxes to be disabled

e Library, C functions: importing a C function from the Library would cause UniLogic to delete the
code from other C functions in the project

Improvements

e Trends:
- Trend widget loads faster
- Now supports axis values
- e Global tag import: now includes a 'Cancel' import option
e REST API:
- if the Base URL is invalid, UniLogic now gives a compilation error

- REST API compilation errors now allow you to click in the error list directly to the error
location
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UNILOGIC® V 1.30 REV52 UNISTREAM® OS 1.30.31 September 2020

Unitronics Fall 2020 release launches a new
member of the UniStream series: a

UnIStl’eam BU||t'|n ContrO”er W|th a b|g . 0il Extraction System

Super Critical CO: &

10.1" panel offering 1024 x 600 (WSVGA)
resolution.

As a PLC + HMI + I/0O, UniStream 10.1 is
available in a broad range of expandable,
built-in I/O configurations, and is available
in Standard (B5) and Pro (B10) models. Both models support advanced communications,
including MQTT, VNC, FTP, SNMP, email and SMS messaging. The Pro version also offers
built-in Webserver, video support and SQL.

UniStream Built-in benefits include auto-tuned PID, data logging, data tables and recipes,
data sampling displayed via built-in Trends and Gauges, Alarms, multi-level passwords,
portrait mode, and plug & play communications for CANopen, CAN Layer2, MODBUS,
EtherNet/IP, Servo made Simple, and more.

Other release features include support for:

e New USL external VNC display panels for UniStream: ‘big-screen’ USL 15.6" & USL 10.1"
e REST API

e PTO, via I/O Module UID-0808THS

New Hardware

With a big, 10.1" Panel offering 1024 x 600 (WSVGA) resolution,
NEW UniStream 10.1 is available in a broad range of expandable, built-in
UniStream Built-in 10.1  1/0 configurations - available in Standard (B5) & Pro (B10) models.

Both versions support advanced communications including MQTT, VNC, FTP, SNMP, email and SMS
messaging. The Pro version also offers built-in Webserver, video support and SQL.

UniStream’s built-in benefits include auto-tuned PID, data logging, data tables and recipes, data
sampling displayed via built-in Trends and Gauges, Alarms, multi-level passwords, portrait mode,
and plug & play communications for CANopen, CAN Layer2, MODBUS, EtherNet/IP, Servo made
Simple, and more.
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Model Family: | 8 Built-in -

Pro 10" Selected PLC

Standard | [B8 577" | [B8& us10-810-81 US10-B10-RA28
107 HMI panel + built-in CPU + built-in 10 configuration
Pro > E 10 > E U510-810-TR22 Built-in ports: 1 Ethernet, 1 USE host, 1 mini USE programming port, audio-out jack

Add-on ports  Compatible with WAC-CX modules
B3 us10-810-124 "’ "

Built-in IO 14 Digital inputs, 24VDC, sink/source, including 2 High speed counter

Configuration  input channels
B3 usto-B10-TA30 2 Analog inputs, 0-10V / 0-20mA. / 4-20mA, 14 bits
2 Temperature inputs, RTD f Thermocouple
E3 usi0-810-rA28 8 Relay outputs

2 Analog outputs, 0-10V / -10-10V 7 0-20mA / 4-20mA, 12 bits

m Us10-B10-T42 I#O Expansion - Uni-1/0 Local Expansion
- URB Remote I/0

- EX-RC Remote 110
B3 usi10-810-R38

Models Features

US10-B5-B1 No built-in I/Os

US10-B10-B1

US10-B5-TR22 10 Digital, 2 Analog Inputs, 2 Transistor outputs, npn, including 2 PWM outputs.
US10-B10-TR22 8 Relay outputs

US10-B5-T24 10 Digital,

US10-B10-T24 2 Analog Inputs, 12 Transistor outputs, pnp, including 2 PWM

US10-B5-RA28 14 Digital, including 2 HSC,2 Analog Inputs, 2 Temperature inputs,
US10-B10-RA28 8 Relay outputs, 2 Analog outputs

US10-B5-TA30 14 Digital inputs, including 2 HSC, 2 Analog inputs,2 Temperature inputs,
US10-B10-TA30 10 Transistor outputs, pnp, including 2 PWM, 2 Analog outputs

US10-B5-R38 24 Digital inputs, including 4 HSC,
US10-B10-R38 12 relay outputs
US10-B5-T42 24 Digital inputs, including 4 HSC, 2 Analog inputs,
US10-B10-T42 16 Transistor outputs, pnp, including 2 PWM
Big-screen UniStream USL Displays 10.4" and 15.6" are, included in this
NEW USL release.
Displays

UniStream Displays are a series of color touch-screens that support VNC.
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A UniStream controller can operate as a REST API client and can request

REST API specific data from a server. In order to communicate with an API REST server,
you build a request, comprising Query and Response Parameters.
Search Solution Explorer
b [gsms Server Server
si SQL Connector R -
egues
n f%ﬂEs;ewe” 9 Server Name Serverl .
. w OUEI""{ Parameters Base URL http//dataservice.accuweather.com
# Passwar anagemen Response Parameters REq U'E'St
% User Access Control
End Point Resource | fcurrentconditions/v1/328328
Query Parameters
U Add Query Parameter
s e |
Response Parameters
U Add Response Parameter
[+] IsAmy _MninAnaymdex th _thpmim
PTO You can now implement Pulse Train Output (PTO) via the high-speed outputs of
I/0 Module UID-0808THS.
Using PTO you can, for example, build Motion/Speed profiles that are
appropriate for stepper motors.
__PTO Move DB1 | COM: Serial | Target |
COM: HART | Velocity |
EN ENO . || 4 COM: PTO
| ¢ & PTO Move
UID-0808THS_0 —A D Target Reached ‘ A& PTOSet Home
PTO | 1 € PTO Change Units
PTO Config 1 J B Q E Move Error l B PO Swap pins
f - | 1 COM: CANopen Mini
_FTO Config l.Mo.,._ C Fi_— Move Error 1D l COM: CAN Layer 2 Ug;;l’:tl;m
g -1 Acceleration Deceleration
Time Time
-
N Ti Development Mode and Quick Sync are time-saving features that can help you
ew lime- to develop UniLogic projects more efficiently. You can use them independently,
savers: or both together.
Development * Development Mode: when enabled, this mode saves time by
Mode & Quick temporarily suspending, for 1 hour, the password verification process
Sync performed between UniLogic and UniStream at download.
# Quick Sync: downloads small changes in Ladder, Message Composer,
Switch Case, and Formula, while other changes are ignored. This can
save significant download time during project development.
UAC: New The new UAC features listed below are useful for all, but are especially needed
Features

for UAC projects supporting the standard CFR-21 part 11:

UAC User Groups, new Password features:
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# Expired On: Password ageing, the number of days a password will be in
effect for a member of a group before it expires.

# Lockout Timeout: Determines the number of minutes the user will be
locked out before being allowed to attempt to log in.

# Login Attempts: The number of Login attempts a member of a group
may attempt to login before being locked out.

# Alarm Status Viewer widget: If you enable UAC, you can select if
buttons--ACK, CLR, Disable and Shelve Alarm--will be visible to a specific
User Group.

Additional features

HMI Trends:

o When a Trend graph is displayed, you can now press a new button in the top left corner
to hide the buttons and increase the viewing space, and press again to display them.

o Trend properties now include an option to change the background color of the Curve text
(the default is black)

Via UniApps, you can now enable UniStream to register when a connected VNC client screen is
touched. In UniApps, access the Network tab-> VNC Server, check the Set 'touch bit' and press
apply. The VNC server will restart with the VNC "touch" identification option enabled.

USB Action Files: you can now include a PLC Password, selecting either to retain the default password, or
overwrite the current password with a value that you provide.

Modems: when you add a modem, you can now add a Signal Quality Refresh Rate.
Message Composer: now supports REAL tags.

Bugs fixed in this version

These have been fixed in the current version:

MQTT Minor bug fixes

Modem / SMS / Email: emails were received from certain servers without a 'From' header.
USL: sometimes was is disabled in UniApps.

UAC: Users could log in, although another user was already logged in; a notification will now
pop-up requesting logout.

Ethernet/IP In certain circumstances, EDS import would fail.

HMI keyboard: in Portrait view, the alphanumeric keyboard was missing the Z character.
UniApps: Project Export to USB stick did not request a password.
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UNILOGIC® V 1.29 REV103 UNISTREAM® OS 1.29.128 May 2020

Unitronics Spring 2020 release introduces brand new hardware and powerful new software
features to broaden your project potential!

New Hardware

New Ethernet-based URB components:

- I/0O modules: Loadcell/Strain-gauge, PWM, and Pulse I/O modules

- I/O adapter:URB-TCP2, a compact, competitively-priced adapter that supports up to 6
URB I/O modules.

Introducing Unitronics 4G Routers! Our new 4G/LTE & WiFi cellular Routers support
embedded SMS functionality, RS232, RS485, GNSS (GPS), microSD, USB interface, and
on-board Digital & Analog I/0s.

New Software

BACnet IP Server: Yes, UniStream controllers as BACnet IP Servers! The broad range of
Services, Objects, and Tasks enables you to blaze new ground in Building Automation
and Environmental Control. Compatible with all UniStream controllers. We invite you to
activate the trial license to check it out!

High-priority Ladder Task + Immediate Ladder Functions: *Supported by the following
models: US5/7-B5/10-T42 and USC-B5/10-T42.

Motion Control: - Update Firmware Wizard: | New Motion Control Functions: Apply Torque
/ Apply Force | New Actuators: Rack & Pinion, Roll-feeder / Conveyor |- Upload Axis
Parameters to PC

EtherNet/IP: New EDS Features: Scanner: Import a manufacturer's EDS configuration|
Adapter: create and export an EDS file for adapter nodes you define in UniLogic.

Authentication New!: Embedded user authentication now requires a PLC password before
executing commands and tasks; simply install this UniLogic version, upgrade UniStream
firmware--and gain increased security.

to industrial automation. This version requires users to enter a PLC password before executing

Regarding Authentication: Unitronics tracks the dynamic challenges that cybersecurity present

commands and tasks. UniLogic includes a default password. Please change the default
password to minimize exposure to un-authorized cyber users.

-Clung: PLC Password
A The current PLC access Password is the default password

We highly recommend you take this
opportunity to benefit from the
increased Security offered in thlS Unitronics recommends that you set your own password to minimize exposure to non-
version release. penied oyber e

To do so, you must update your

UniLogic software, upgrade UniStream |
firmware, and download an application
created/updated in this current version.

Il Stop reminding me for this PLC, I'm aware of the potential risk and choose to continue
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Read on to learn of other exciting features in this release, including new servo Motion
Control functions, new Actuators, and more!

Spring 2020 Feature List

Hardware Configuration now offers new additions to our line of URB Ethernet-

# Compact I/O Adapter URB-TCP2, which can support up to 6 URB I/O

# New I/O modules, including Loadcell/Strain-gauge and PWM modules

Souion porer [ TANIRE

Modules Configuration | 4 Losd Cell moduies

NEWin based Remote I/0:
Remote URBI/0

modules
Model Feature
URS-02LC-8 Load Cell
URD-04PW  PWM, 4 Channels
URD-02PW PWM, 2 Channels
URD-02PU Pulse2 Channels
URA-0800T 8 Analog Inputs, Current
URA-0800U 8 Analog Inputs, Voltage
URA-0008Y 8 Analog Outputs, Current
URA-0008Z 8 Analog Outputs, Voltage

5 Hardware Configuration
3 Controller Model (USE
H Uni-1/0 & Uni-com
4 § URB Remote /O
4§ URB Adapterl

& URS-02LC-8_0

[lex-RC Remote /O
> B Motion Drives
Sen——

Drag Modules from the Toolbox 10 the desired location

& URS-02LC-8 (S02LC8)

Input Process imoge Size: 16 / 128 Byzes 4 Analog Output modules
Output Process Imoge Size: 2/ 128 Byres | gly URA-0004W (AO04W)

10

O Name

W URB Adapterl_Inputs

| |eumasoos onm
& URS-04TC {S047C)

Properties Window
78\ URS-02L.C-8_0 [URS-02LC-8]
» Configurations

Sampling Filter... Eﬁaﬂ\g

« General Specification T
Input Size (bytes) 16
Output Size (by... 2

Type Power Dissipati... 25

W) URB Adapterl Outputs

0 + Measurement
Dimension (mm) 7

0 5

iads Weight (q)

10 » URB Adapterl Inputs » URS-02LC-8_0

w N o

Bridge input 0

INT32

[ Reference input 0 INT32

Bridge input 1

Reference input 1  INT32

INT32

-

IO » URB Adapterl_Outputs » URS-02LC-8_0

0 @ Tare 0
1 @ Teret BIT Binary
2 (&) Reserved 0 BIT Binary
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Unitronics new 4G cellular routers enable you to send and receive SMS messages via
Ethernet. Hardware Configuration now offers these models:

¢ UCR-ST-B5
4G /LTE & WiFi cellular router with 2 Ethernet ports and I/0

e UCR-ST-B8
Dual-SIM 4G/LTE & WiFi cellular router with 4 Ethernet ports, Digital & Analogue I/Os, RS232,
RS485, GNSS (GPS), microSD, and USB interface

Routers

Enable Router

Solution Explorer

Search Solution Explorer J

Enable Router

4 ; Solution TestRouterApp'

4 [Praject

P HREHardware Configu
P B Motion
4 FBMPLC Communicatic
L4 gugl:'h}rsical
P BlProtocols
P D padems
@Lﬂouter
4 §RE | adder
4 @ Modulel
,\?Functionl
A H AT
4 G Modulel
[C1Screenl
Ed Custom Contre
@-Web Server
L ¥alarms
SEL Actions
B Data Tables
Data Tables Recipe
‘ﬂData Sampling

|| p—

-

Configuration
Authentication
Receive SM5

Authorized numbers
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iz 10,1 .30 ~220]
3 R = —
Authentication

User Mame Spock

Jzzzword  eessssses A
Receive SMS

[F] Enabie Recsive Smz

Authorized nhumbers

@ Add New Authorized Number

# || Phone Number

0 | +372 - 111111111




BACnet Server

A
UniStream Seners X

I
controller #-diiProtacols ‘
4 OBACnet u Add New BACnet Server

can now 4 [20 Servers

4 (O BACnet serverl
a Ct as a ovo | UniStream embedded BACnet server operation additional information please contact y
BACnet
MI o ‘. 4 7 1 BACnet server Unitronics 1207

. Trend L Mul

SUDDOI‘tIng O Trend Logs
a range of
Services, Objects, and
Tasks.

Note that BACnet Server requires a license
purchase, available from your Unitronics' o T— Licensing

sales representative.

Unitronics offers you a One-hour Trial Offer,
in order to enable you to explore this new
exciting feature. Note that each time you
power up your controller, you can restart
the One-hour Trial Offer.

To learn how to activate the Trial Offer, refer

i actatin

Feature L | Activated

to the BACnet Server topic in the UniLogic e e s Start BACnet Licensing

Help.

Ladder: High-
priority Ladder
tasks
(Interrupts)

System @ Memory

A High-priority Ladder task runs independently of your Ladder
program according to a specific time interval. Use them with Ladder functions
Immediate Read Input/Input, Immediate Set/Reset Output.

These features are only visible in UniLogic when you select supporting models
in Hardware Configuration, such as the US5/7-B5x-T42 and USC-B5/10-T42;
when unsupported models are selected, these features are hidden.

UG Uni-Lf0 & Uni-COM % Functionl X

H Uni-vo & Uni-com
4 URE Remote 'O
lE'{--'?.: Remote /O

» B vistion Drives

. Motion

ERPLC Communications

4@ High priority module
AHFH gh prionty task

Basic Elements

B Hardware Configuration Compare
Bl Controller Model [US5/7-B10-T42) EN ENO Math

Logic

HSCCU’:E'S.HSC...HA [&, Bi—  Motor Puises |

Immediate Read Counter . . .
T %] Immediate Read Input

4 [0 Manipulation

|E| Immediate Read Counter

[®] Immediate St Qutput

m |'9_-:! Immadiate Reset Qutput
EN  ENO EN  ENO
R &)

::J i : » High Priority Task Interval
}—B ol Immediate et Qutput | > High Pricrity Task Interval |domgy

1ms

Motar Pulsas }—A ; HS DL[':I'J:E.DLIT:I...}_.&

Limit

Zms
3ms
4 ms

5 ms
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Starting with this UniLogic version and the accompanying UniStream

Authentication: . vare Unitronics embedded user authentication measures into both
UniLogic to UniLogic software and UniStream firmware. This enables you to prevent
UniStream unauthorized access to your UniStream controller.

For this reason, UniLogic requires users to enter a PLC password before
executing commands and tasks that require UniLogic to UniStream
communication.

The first time a user establishes

UniLogic to UniStream communications ' Change PLC Password

to a particular PLC, for example at

application download, or to run online 'l\. Change your PLC password

Test mode, UniLogic prompts the user = Your current Password is the default Password.

to change the default UniStream access Itis highly recommended you change it to 2 unique password.
password. Do you want to change it now?

For details, including how to restore the Yes | Mo
default password, refer to the Help
topic Authentication: UnilLogic to

UniStream

This version offers several new Motion Control features, plus a new Servo Firmware

Motion Update wizard.

Control

Update Firmware Wizard

oG9 =
You can easily update your B Ly PLC
Unitronics' UMD Servo firmware 3 Welcome to Unitronics Servo Firmware Update
via the Wizard. now available on e n order to update, carry out the on-screen instructions.
! . Drive Fimvire Update Before you begin
the Servo Drives ribbon tab. — -

1. Check that your Servo is a Unitronics device; check the
serial number and model via the sticker on the Servo side.

2. Connect your Servo to your PC using the correct cable
supplied by Unitronics.
Press Next to begin

New Motion Control Functions
The Ladder Toolbox offers two new MC functions:

® MC Apply Torque
Enables you to set Torque and apply it according to the physical values you define in the Axis
Configuration, regardless of the motor specification.

e MC Apply Force
Enables you to set Force and apply it according to the physical values you define in the Axis
Configuration, regardless of the motor specification (linear actuators only).

In addition, MC Move Relative and MC Move Additive now support Continuous Update; set a bit to
evaluate input parameters at each cycle.
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New Actuators

Two_new actuators are available: Rack & Pinion, and Roll-feeder / Conveyor, allowing you to
convert rotary movement to linear values.

4 Actuators
=fi Rack & Pinion actuator
"= Reoll feeder / Conveyar

= Linear actuatar
{=] Rotary actuator

Upload Axis Parameters to PC

When you configure an axis, the values you enter in the Axis Struct are written to the axis at
power-up. When you enter values from the HMI, the axis functions according to these values, but
the values you have entered will be overwritten at power-up.

To overwrite the values in the axis struct, use Upload Parameters in PC.

Project =0 Layout PLC

Twl;|

% Hxis: Axis]

Stop . .
Diagnostics Axis State: Standstill

Diagnostics control

Solution Explorer

Search Solution Explorer

Diagnostics Parameters | Help

= 4

Export Upload
To Excel | Parameters to PC

Parameters

EE i Diagnostics Trace X
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Maotion Diagnostics X

Configured value

Functionl X

Read value

4 T Solution 'Serve_New' Units 0.1 mm 0.1 mm
4 [3Proj
LeProject Position factor numeratar 4194304 4194304
P i Hardware Configuration
4 [ Motion Pesition factor denominater 375 375
P W Aes Maximum acceleration 600000 BO0000
4 | Mation Diagnostics . :
.D rS— I Maximum velocity 20000 10
[ | Diagnostics Trace Maxirmum deceleration 600000 600000
P RIPLC Communications Software position limit maximum 0 0
4 2| adder
4 B Modulei Software position limit minimum 0 0
5 Functiont .
& UMD _Userlp Homing acceleration 0 0
4 BEHM ,
4 T Modulel Homing stopper torgue 20 20
ClSereent Homing blocking time 100 100
4 @ UMD _Diagnostics Emergency stop option 3 5
C_UMD _Main _ _
D UM D_Mls_l.lmlti_cﬂﬂﬁg Chsable éptlﬁﬁ 0 0
EIUMD_Axis_Motion_Config  Halt aption 1 1
EUMD_fxis_Position_Config
- - Z relocity tol 0 0
EUMD _Axis_Scalling Config | —T1C Velocity tolerance
CUMD_Axis_Stop_Options Zero velocity tolerance time 0 0
EUMD_Asis Torque_Config  payimum torque 3000 3000
EUMD_Axis_Velocity_Config _
EUMD_Drive_Config Emergency stop deceleration 4204967295 4204967295
FEIHATE Hal | Mation profile 0 2



Additional Motion features

Axis Interface: Automatic conversion and rounding in Actuator properties. When you change the
Unit setting, UniLogic now converts the value; for example, if Unit was set to pum and the value was
1000, setting the units to mm converts the value to 10.

Custom Units: You can now select Custom Units when working with linear actuators.

You can now:

EtherNetIP: c c N

® Import a manufacturer's EDS configuration, when you set UniStream
NEW EDS to act as as a scanner.
Features

# Create and export an EDS file for adapter nodes you define in
UniLogic.

_ Web Server X [Tl g VNC Clients X Password Manag

4 §8PLC Communications
> .".Ph)xcal I 9
4 SBProtocols

» OBACnet Bo
e OPC-UA =
Ni VNC Cients J ! A0 Mew Scincus Node b RP1 [ms] | 120 Assemb
L UniCAN I Agg New Scarnes Noce From EDS
P SNMP
» 1 MoDBUS
> EIMQIT
> FTP £DS_DATALOGICCBX-l 0.0.0.0 '8 101 EDS_DATAl
4 % EtherNet/1P
2% Scanner (@} My Nodel 0.0.0.0 16 0 Godzilla
BB e —
S Name = ] #s7 Type .
9 £0S_DATALOGIC C8X-IOL-8-EIP EIP Scanner Node Struct |
IGlobal » EDS DATALOGIC CBX-IOL-8-EIP
T
() Connected Bit 8T
(&) Enable Node Bit BIT 1
&) explicit Busy BIT
[T) Device Name STRING-ASCII
) Config Size (Bytes) UINT16
& Connection Status UINT16
) Device Type UINT16
B Input Size (Bytes) UINT16 499
Bl Qutput Size (Bytes) UINT16 499
&) Product Code UINT16
& RP1O2T UINT16 g
B RPLT20 UINT16 8
& VendorID UINT16
i Disconnections UINT32
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Additional Features

MODBUS

CANbus
"Sniffer
Filter"

MQTT

VNC Server
OPC UA

Alarms

UAC

DT widget

RTC Time
zone

Schedule
HMI

Emails

FTP

# New Operations: MODBUS command 0x17 Write/Read Multiple Registers -
Periodic and Aperiodic.
These operations perform a combination of one Read operation and one
Write operation in a single MODBUS transaction.

# You can now export and import a UniStream MODBUS Master's slave
definitions, via a proprietary Unitronics file.
# You can now assign a MODBUS slave a Unit ID of O

The addition of a CANbus "Sniffer Filter" can help you monitor--and debug--
only the specific CANbus units you specify, according to ID. Note that this can
be helpful in Servo applications.

# You can now assign a machine identifier to an MQTT topic:
{PLC.MAC},{PLC.SN},{PLC.NAME?}; PLC Names are assigned in UniApps.

# The user name in MQTT Broker Connection has been increased to 128
characters.

Now supports 1024x768 resolution
You now have the option to import client certificate files.

e You can now Export/Import Alarm groups
e At reboot, the Alarm Summary is how retained

New option - numeric keypad instead of alpha numeric

You can now display the Descriptions of array members; formerly you could
only display the index humber
Now supports partial hours.

Times can now be entered in 12h format (AM and PM)

The email TLS version was upgraded to TLS1.2

Limit the access to FTP to specific folder
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Bugs fixed in this version

These have been fixed in the current version:
e Data Sampler History file: in certain situations, Force Sample did not function correctly.

e UniCAN Communication: When CAN cable was disconnected and reconnected, or CAN power
cycled, Tx between UniStream and V1040 would fail

e Initial values of retained tags: Sometimes did not update in PLC after regular Download
e Web Trend: Curve Names in Legend, were not visible when the Plot was set to white Fill

e Alarm Summary\Banner: When the alarm name contained the characters the alarm did

not display in Alarm Summary\Banner
e SQL Query: Using a constant with parameters that included non-English caused a 'CPU Error'.
e UID-0200E and UID-0200D: Configuration sometimes did not download to PLC.

e Web Server: State machine button would show a false positive compile error when linked to a
numeric tag that was not INT16

¢ 'MQTT Send Aperiodic': when sending values that were stored on the same Ladder net, would
send old values

e email: email with data sample attached as csv.zip, could not be sent
e Store DTI to File: If Append + only CSV options was selected, no file would be generated

e Modem Init Ladder function: In certain cases the function returned Success, when using a
modem without a SIM

e USBF: Could not write retained tags to the file

e URS-04RT: Would use a UINT16 instead of an INT16, which does not provide for negative
temperatures. To fix existing projects, the I/O module needs to be removed from Hardware
Configuration and re-added.

e Alarm file: not all Alarms were saved after after reboot

e MQTT: Cannot connect to Broker with a tag bigger than 1kb
e Message Composer:

e -CRC was not calculated correctly in specific numeric values

e -sometimes failed to build a message if it included a UINT32 value
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UNILOGIC® V 1.28 REV34 UNISTREAM® OS 1.28.58 December 2019

This is a Service Pack version, UniLogic 1.28.34, OS 1.28.58. This service pack is for
the previous UniLogic version 1.28.26 and OS 1.28.39 released in September.

This version includes the features and bug fixes listed below.

Features

The Receive buffer size has been increased to 4K RX, enabling larger messages
to be received via the Rx COM port.

UniApps now offers an Ignore Uni IO Popup button, located in UniApps under
System-> System Logs.

Store UDTF to File:

-Using this function to append data requires a UDTF file. Therefore, if in
parameter E, you select option 1, Append to File, you must select either options
1 or 2 to create a UDTF file in parameter F. If you select, selected either options
2 or 3 (create .csv only or create .csv.zip only), the status parameter will
indicate -14: append UDTF file error

-In addition, there is now a new status indication -8: signature file error

Bug fixes - fixed in this service pack

UniCAN connection between UniStream and EX-RC/RC1: in certain cases, the
connection was not re-established after disconnection.

Ethernet/IP scanner: in some cases, the Ethernet/IP scanner was not able to re-
establish connection with the adapter.

Trend Widget History Button, HMI & Web: the button was greyed out and
disabled in the previous version.

Email: csv.zip Data Sample attachments could not be sent.

System -> RTC Date -> Day of the week: when the day of the week was set to
Saturday, the tag value did not update to 7.

Mail Configurator Widget: under certain circumstances, selecting To/Cc/Bcc
caused an HMI Application Overload.

HMI:

- Numeric box: at times, UniLogic did not allow the user to link an array
member to a humeric box.

- Custom controls: UniLogic displayed these on a black background, appearing
blurred, instead of being transparent.

AutoStart: in certain cases, the system did not recover from a crash, if a
defined CANbus node was not found.

Multi-Touch keyboard: in certain cases, the Virtual keyboard of multi- touch
models did not respond.
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UNILOGIC® V 1.28 REV26 UNISTREAM® OS 1.28.30 September 2019

Unitronics fall release for 2019 launches a

MC_Move Absolute

major addition to our All-in-One Solution:

H MC_MoveAdditive
Motion _Contr(_)l. Our full range of Sgrvo_s and
Motors is easily programmed in UniLogic; the ( viscrete Mation e »Continuaus Motion)

Ladder editor offers PLCopen-compliant MC TNl
Function Blocks. In addition, Unitronics
supplies you with Ready-made Motion code;
this enables you to immediately get moving
with your Motion system.

MC_Stop

Stopping
A

...........

UniLogic greatly simplifies servo applications (" woming %! standstill

by enabling you to:
[ P oot Mo 104810 X |

4 Reducers

> Drag & drop drives and motors into your . . ot
. i . . ! Mechanical properties
project: UniLogic automatically defines the correct . L petendpdey
" . . { y 4 Actuators
configuration and automatically sets up I F— ii—o — Linear actuator

{=] Rotary actuator

communications for you

Properties Window e
Units = Units settings

Units degree A

obutian Travel distance 360

> Add up to 8 Axes, drag & drop actuators;
UniLogic automatically converts units

. Input shaft rev... 1

3 Motor Revahutions

s+ Torque settings

* Benefit from automatic calculations: UniLogic L mwmrae | Togeunts  |[m -
analyzes the mechanical properties of your B : BTt Moxinputtorg.. 1
. ynamics Efficiency [%] ap
selections and recommends safe values - Speed settings
. - — Max speed [uni.. 1
] Use the Ready-made Motion application to

execute movements, such as Point-to-Point, Jog, and Homing--you can open this
application and edit as needed to adapt it to your motion requirements

65 Unaronics - TightVYNC Viewer ol o s
BEHERD N S| @R Qaae B

* Program Motion Control via drag & drop,  peseses—— r—
using industry standard motion Function ’

Blocks (PLCopen)

L Tune your system using a single @ simple Tuning
parameter .Manual‘l’\mlng
> Diagnostics: View servo run-time
performance via UniLogic’s built-in powerful,
high-speed scope g jolc)
o) Communication: State: StandsStill
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Another major feature of this release is OPC UA - UniStream controllers can now act as

OPC UA servers.
Click to copy

_ Address Space X [FTGTRTTUOETEEE OPC-UA X

orer

Settings Seftings
1 Sl Pratocols ng
4 e QPC-UA Authentication | Application Name  UaServer
i'—‘Ser-.-er S 3 . Host Name UniStream
Address Space Security Policies

Wi VNC Clients - Port 48020

2 UniCAN Certificate _ . b _
[ .;rn.un End Paint : opCtopef/Lri.1b.8. 1880, ar | ThlS

release also includes additional features.

Feature List

Motion Hardware Configuration now offers Servo Drives and Motors.

In addition:
e The Ladder editor offers COM: Servo functions, and PLCopen-compliant MC Function Blocks

e Unitronics supplies you with Ready-made Motion code; this enables you to immediately get
moving with your Motion system.

OPCUA UniStream controllers can now function as OPC UA servers.
Digital , . )
. The Data Table files generated by the function Data Table: Indexed> Store DTI to
Signature File are now automatically stamped with a digital signature.
Ladder: New Ladder Functions enable you to draw shapes, and groups of shapes on the
Draw HMI screen (Not yet documented)
RTC UniStream now supports two clocks, Local Time and GMT. You can use these in Ladder
/GMT elements, HMI Widgets, and set them via UniApps.
& A new parameter has been added to the RTC struct, Time Zone
) Existing Ladder functions Set PLC Time/Date now have a new parameter, Status.
& New System structs have been added, UTC Time and UTC Date

Additional features

IO bus system struct now includes a tag: IO Boot Reset
Web Data Table element now includes Show Last Update
Web Data Table width limit reduced to 300px

Caption of the table in Data Tables widgets (HMI/Web)
SQL now includes Test Connection

CANopen: CANopen nodes can now be duplicated

HMI:

— Message Boxes can now be aligned

- Message Box Buttons: location can be changed

— HMI Slider: ticks color may be changed

- HMI Trends: Background Color, Grid Color and Plot Color can now be changed
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& Alarms offer new options:
- Alarms Silent ACK
- hide the Snooze button
— display the alarm banner only if there's an alarm
e CRC ladder element: new CRC_ASCII option
e User Access Control, User options, now has two new options::
— Show User Name; un-check to hide a user's name in the Scroller at login
— Allow Change Password, un-check to hide that option from the user
& Store DTI To file, new options:
— 0 - No CSV File (Only udtf)
— 1 - Create CSV File (ALL udtf/csv/csv.zip)

- 2 -0nly csv
— 3 -0Only csv.zip
& SD Management now includes Data Table files
& The following passwords now support up to 16 characters:

— UniApps Administrator
— UniApps Guest

- Upload

— Import/Export App
& Project Level Actions: Now includes Safely remove SD and Safely remove DOK (memory stick)
& String tags have been increased to 256 characters
L Online mode view: maximum tag size increased from 256 bytes to 514.

Bugs fixed in this version

& In certain cases, the Web tables index column ("#") would sometimes present only zeros..

& Using */ in region or rung comments would cause compilation errors.

& If the project was created when the UniLogic UI language was set to Chinese or Czech, SD
Management did not work.

L Web-Server - HyperLink did not work when linked to a Const string tag

& While linking an array to FB in Ladder, when selecting the array with the mouse cursor, the
keyboard input did not function

& If the user selected URB modules before selecting a power supply, the modules did not function
correctly.
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UniLogic V1.26 Rev 90 UniStream 0S 1.26.91, May 2019

Hardware Configuration

UniStream PLC Hardware Configuration now offers UniStream PLC +1/0Os controllers.

The series is available in three versions: Pro, Standard, and Basic.

Note that a model humber that includes:

e B10 refers to Pro version (e.g. USC-B10-T24)
e BS5 refers to Standard version (e.g. USC-B5-RA28)
e B3 refers to Basic version (e.g. USC-B3-T20)

B3 sasc B3 uscsi081 | uscBio-R3s

E Madular
B3 suitt-in
e

Features

Power
Features

I/0
Options

COM
Options

COM
Protocols

B3 standara | B8 usc-s10-TR22

> ﬂPro

CPU + built-in L/O configuration
Built-in portss 2 Ethemet, 1 USB host, 1 mini USE programming port

Add-on ports  Compatible with UAC-CE modules

> B3 usc-810-124 F peEEw
Built-in I/O 24 Digital inputs, 24VDC, sink/source, including
Configuration 4 High speed counter input channels

E USC-B10-TA30 2 Analog inputs, 0-10% / 0-20mA / 4-20mA, 12 bits

12 Relay outputs
E USC-B10-RAZ8 /O Expansion - Uni-1f0 Local Expansion
- URE Remote [/O

B3 uscsi0-142

E USC-B10-R38
%" Change PLC Model

Built-in Trends and Gauges, auto-tuned PID, data tables, data sampling, and
Recipes

UniApps™: Access & edit data, monitor, troubleshoot & debug and more
Security: Multi-level password protection

Alarms: Built-in system, ANSI/ISA standards

Built-in I/O configuration, varies according to model

Local I/O expansion via Uni-I/O™ modules, and UAG-XKxxxx I/O expansion
adapters

UniStream Remote I/O Ethernet adapters and modules
Built-in ports: 2 Ethernet, 1 USB host, 1 USB device port
Add-on ports (UAC-CB), available by separate order:
o 1 CANbus port may be added to all models
o RS232/485 ports: according to model technical specifications

Fieldbus: CANopen, CAN Layer2, MODBUS, EtherNetIP and more. Implement
any serial RS5232/485, TCP/IP, or CANbus third-party protocols via Message
Composer

Advanced: SNMP Agent/Trap, e-mail, SMS, modems, GPRS/GSM, VNC Client,
FTP Server/Client

Remote Access via any device that supports VNC
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Programming
Software

HMI

Differences
between
B10, B5,
and B3

All-in-One software for hardware configuration, communications, and HMI /PLC
applications, available as a free download from Unitronics.

All UniStream PLCs can display HMI screens on the following devices:
e UniStream Display (USL)

e UniStream Modular HMI panel (USP)

e UniStream Built-in (on the panels integral to the device)

e Any device screen that supports VNC client

HMI screens are designed in UniLogic. In addition to the HMI screens, UniStream
PLCs offer built-in HMI features, including:

e UniApps™: Access & edit data, monitor, troubleshoot, debug, and more
e Security: Multi-level password protection
e Alarms: Built-in system, ANSI/ISA standards

Feature B10 Pro B5 Standard B3 Basic
I/O Expansion via Uni-I/0O Yes No
Remote I/O Expansion via Ethernet I/O  Up to 8 1
Adapter (URB)

VFD 32 2
MicroSD Yes No*
Add-on COM modules 3 2
System Memory 6GB 3GB 3GB
MODBUS Slaves Unlimited Up to 8
Ethernet/IP Scanners 16 1
Ethernet/IP Adapters 32 8
Web Server Yes No No
SQL Client Yes No No
MQTT Yes

PID Loops 64 2
Data Sampler/Trends Yes No
CSV files: creating/ reading Yes No
FTP, server/client Yes No
Saving Data Tables to SD Yes No*
Screenshots Yes No
Sending email attachments Yes No
USB device (programming port) Yes No**

* Note that B3 models do not support features requiring SD cards. In addition, Alarm History is not
retained after PLC reset.

** Note that B3 models may be programmed only via Ethernet cable.
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UniStream PLC
Models

The built-in I/0O configurations are indicated by the last group of digits in the
model number. For example, USC-B5-TR22 and USC-B10-TR22 have identical
I/0 configurations.

USC-B5-B1 These models do not have built-in I/0Os.
USC-B10-B1
USC-B5-TR22 = 10 Digital inputs, 24VDC, sink/source

USC-B10-TR22

*= 2 Analog inputs, 0+10V / 0+-20mA, 12 bits
= 2 Transistor outputs, npn, including 2 High speed PWM output channels
= 8 Relay outputs

USC-B5-T24
USC-B10-T24

= 10 Digital inputs, 24VDC, sink/source
*= 2 Analog inputs, 0+10V / 0+20mA, 12 bits
= 10 Transistor outputs, pnp, including 2 PWM output channels

USC-B5-RA28
USC-B10-RA28

» 14 Digital inputs, 24VDC, sink/source, including 2 High speed counter input
channels

» 2 Analog inputs, 0+10V / 0+20mA, 14 bits

= 2 Temperature inputs, RTD / Thermocouple

= 8 Relay outputs

» 2 Analog outputs, 0+10V / -10+10V / 0+-20mA / 4+20mA, 12 bits

USC-B5-TA30
USC-B10-TA30

» 14x Digital inputs, 24VDC, sink/source, including 2 High speed counter
input channels

» 2 x Analog inputs, 0+10V / 0+20mA, 14 bits

= 2 X Temperature inputs, RTD / Thermocouple

= 10 x Transistor outputs, pnp, including 2 PWM output channels

= 2 x Analog outputs, 0+10V / -10+10V / 0+20mA / 4+-20mA, 12 bits

USC-B5-R38
USC-B10-R38

= 24x Digital inputs, 24VDC, sink/source, including 4 High speed counter input
» 2 x Analog inputs, 0+10V / 0+20mA, 12 bits
= 12 Relay outputs

USC-B5-T42 = 24x Digital inputs, 24VDC, sink/source, including 4 High speed counter input
USC-B10-T42 * 2 x Analog inputs, 0+10V / 0+20mA, 12 bits |

= 2x Analog outputs, 0+10V / -10+-10V / 0+20mA / 4+-20mA, 12 bits

= 16x Transistor outputs, source (pnp), including 2 PWM output channels
USC-B3-R20 = 10 Digital Inputs,

= 2 Analog Inputs

= 8 Relay Outputs
USC-B3-T20 = 10 Digital inputs,

»= 2 Analog Inputs, 8 Transistor Outputs, pnp, including2 PWM Outputs
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USB Action This is a special UniStream PLC feature; it enables the user to carry out certain task

Files: without the need to interact with the PLC via an HMI panel.

Interact Programmers can create Action files in UniLogic and save them to a USB mass storage

with the device, such as a flash drive. The end user can plug the drive into the PLC's USB port,

PLC and then press the Confirm button on the front of the PLC to run the file and execute
the Actions.

Actions include

Upfatinkg ﬁrt?ware and Conoter s wsce10-mzs, N oo e

network settings, . s

downloading piter B

applications, extracting Change current PLC Model | g n-ﬁumusam-| Data ] Read Data Samples

| Read Data Tables
7] Read Retained Memory

log files, and more.

Ls ]
In order for Actions to .y - ¥ Virie Retanedemery
execute, the PLC must Set Permissions Vpdates Logs
I . .
have permission. USB Communication g::e:j:)lfstemll:ogs
. . . . L} larms Log
Action Permissions are Updates

set in Hardware Co,
and are written to the
PLC at download

9' Update PLL Application
& Update Firmware

= —————— cOml“UlliCﬂtiQ"

: .?; -] Ll Read Network Settings

lyze Signature | USBAction N UniBACnet  UnikN) 7] Write Panel [P

1 ’ h - | Write CPUIP
Create Action ect Log Files Creator || Configurator Configurs @] Write DS Seftings

azu F&é:
24

Files External Toc| —
Creator
Data | Data
Logs 7] Read Data Samples
[Z Read Data Tables

Updates | % Read Retained Memory

o [F] Write Retained Memory
Communication Path: |

Logs

| [7] Read System Logs
[T Read Alarms Log

Updates

| [l Update PLC Application
= Update Firmware

Communication

[F] Read Network Settings
[#] Write Panel 17
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Hardware Configuration now shows over 20 new UniStream Remote I/O modules.

UniStream
Remote
I/0: New Digital Inputs |
Models URD-1600-8 16 Digital Inputs (Sink / Source), 24VDC
URD-3200-4 32 Digital Inputs (Sink / Source), 24VDC
URD-0400B 4 Digital Inputs, 120VAC
URD-0400C 4 Digital Inputs, 240VAC
Encoder / High Speed Counters
URD-0200E 2 High Speed Counters / Encoder Inputs, 24VDC
URD-0200D 2 High Speed Counters / Encoder Inputs, 5VDC
Digital Outputs
URD-0008CI 8 Digital Outputs, (Source), 24VDC/2A

URD-0016CG-8 16 Digital Outputs, (Source), 24VDC/0.3A
URD-0032CG-4 32 Digital Outputs, (Source), 24VDC/0.3A
URD-0008NI 8 Digital Outputs, (Sink), 24VDC/2A
URD-0016NG-8 16 Digital Outputs, (Sink), 24VDC/0.3A
URD-0032NG-4 32 Digital Outputs, (Sink), 24VDC/0.3A

Relay

URD-0004SK 4 Solid State Relay, 240VAC/DC, 0.5A

URD-0004SM 4 Solid State Relay, 110VAC/DC, 1A

URD-0004SN 4 Solid State Relay, 24VAC/DC, 2A

Analog Inputs 12 bit

URA-16000-8 16 Analog Current Inputs 12bit

URA-1600P-8 16 Analog Voltage Inputs 12bit

Analog Inputs 16 bit

URA-1600T-8 16 Analog Current Inputs 16bit

URA-1600U-8 16 Analog Voltage Inputs 16bit

Analog Outputs 12 bit |
URA-0004X 4 Analog Voltage Outputs 12bit

URA-0016X-8 16 Analog Voltage Outputs 12bit

Analog Outputs 16 bit |
URA-0016Z-8 16 Analog Voltage Outputs 16bit

Temperature |
URS-04RT 4 RTD / Resistance

URS-04TC 4 Thermocouple / mV

URS-08RT-2 8 RTD / Resistance

URS-08TC-2 8 Thermocouple / mV
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HART Support: The new UNI-I/O model UIA-0800NH, offers 8 analog channels with HART

New Uni-I/0 communication.
UAG-ex: UniStream CX Long-range I/O expansion adapter + embedded Power Supply for
XKPLXXXX UniStream controllers offering jacks, such as the UniStream Built-in series.

Available in lengths of 600, 1200, 1500, 2000, 3000 cm.

SSILELTIEY Uni-I/O & Uni-COM X

Uni-1/0 and COM Configuration  |seach

Drag [0 medules from the Toolbox to the desired location BE UIS-WCB2 -

L unimacnice

=
W]
g
e
*f
3

4 Short/Long Range Uni-I/C
HE UAG-XROX

EHE UAG-XKPXXX

HY UAG-XKPLXXX

4 Communication

B8 UAC-CB-01CAN

B8 UAC-CB-01RS2

H® UAC-CB-D1RS4 =

£

Additional Features

Properties Window -
H8 UAC-CB-01RS2 0 [IO Unit] -

Jo

Set PLC Configuration A new Ladder function enables you to load configuration files that modify the

from file parameters shown below.

Function

Editable Parameters

Write Email Accounts

ini file

[EMAIL_ACCOUNTS:Account1]UserName=Spock
" [EMAIL_ACCOUNTS:Account1]Password=VulcanRocks

[Version=100] \
[EMAIL_ACCOUNTS:Account1]}OutgoingServerSettings=ent. man.dd:1 |

User Name, Password,
Outgoing Server Settings,
From

User Name, Password, Port,
Remote IP

FTP Client
Place it
on SD : ! -
card . FTP Server

User Name, Password, Port,
Read Only

FTP RAM Server

User Name, Password, Port

Stanus Panel: Network
settings

IP Address, Subnet Mask,
Default Gateway

COM Modbus

COM txrx/com

Baud Rate, Data Bit, Parity
Bit, Stop Bit

Switch Case You can define groups of Switch Cases, and then run them via the Switch

Case Ladder function.

This enables you to run multiple Compare operations in a single case, and use

the results to drive one or more events.
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Link to the
defined
Switch Case

2. Formulas
4 :: Switch Case

[# i Switch Case2
[# = Switch Case3
B 5D Management

-~ =

Switch Casel

SwitchCase
EN ENO

Switch Cases Value HA @ B —{ Executed Case ID
A -

0 Casel Value

1 Cased Range
2 Case3 Value

3 Cased Value
-1 default Default

In Ladder, the value of A is either
-compared against the values

or

-checked if it falls within range

If true, the selected Action is
executed.

Batch begun
Functionl

-- Do Nathing -- | Number of Batches

Set Bit
Reset Bit

<Empty=

) default
Toggle Bit

Increment
Decrement

Store Tag

Call Function

SQL: Stored
procedure

When you run a stored procedure, you can ignore @ placeholders by checking
the "Is Executing a stored procedure" checkbox for each query.

Queryl A

Name | Is executing a Stored Procedure || Query String

SELECT * FROM Customers WHERE City = @City AND PostalCode = @PostalCode

Edit ‘'Queryl’ SQL Query:

Help:

:SELECT * FROM Customers WHERE City = @City RND PostalCode

Name | Is executing a Stored Procedure || Query String

Queryl s—

SELECT * FROM Customers WHERE City = @City AND PostalCode = @PostalCode

Edit 'Queryl’ SQL Query:

@PostalCode

Status: '2' of '@ named placeholders used in query]
Input parameters:

Order in Ladder | 5String

0 @City
1 @PostalCade

Help:

1§SELECT # FROM Customers WHERE City = @City AND PostalCode = EPostalCode

Status : Warning: No Parameters have been defined.

Enter your query in the box to the left.
Supported:

-Query types: Select, Insert, Update, Delete, Etc.
-Parameter placeholders: ?, :name, and @name
(@ cannot be used When executing a stored
procedure)

Queries are executed via Ladder.

Click Help to learn how.
Help:




email Attachment,
Alarm Logs

You can now attach
Alarm Logs as a .csv file. Attachments

ﬁ Add New Attachment

‘H Source m i - i i F

0 Alarms Logs AlarmLog/Alarml Mame of file || Raw Data [Attachms =

Raw Data (Attachment]
CSV [Attachment) I

New Ladder e Zip File from SD: Locate a file in an SD folder, zip it in .zip or gz format, and
Elements place it in a destination folder on the SD.

e FTP Compare File: locate a file on a remote FTP Server, compare it to a file

on the controller's SD card, and overwrite the SD file if it is different.

HMI Editor e HMI PDF Viewer element: now offers Indirect file name support
Additions e UniLogic HMI Toolbox: sort custom controls according to ABC

e Password box and Text Box HMI: now includes Numeric keypad support.
Alarms Alarms now support several new features:

e Global actions:
o - Create/close and Zip Alarm log
o - Clear all Alarms
o - Clear and Ack all Alarms

e Each individual Alarm now includes:
- Alarm Cleared bit
- Alarm Suppression bit
¢ New HMI Actions:
- Clear all Alarms
- Clear and Ack all Alarms
¢ New Alarm Ladder Elements:
- Modify Alarm texts from CSV file
- Reset cleared Alarm state

Default Language:
Korean

You can now, when selecting a controller, under Properties/Regional Settings,
select Korean, causing the controller to display the Korean keyboard when a
user needs to enter data via the HMI screen.

Modbus

Modbus Groups have been increased to up to 128 groups

Bugs fixed in this version

e RTC Date/Time is now editable while in "Online" mode

e Web Server: State Machine buttons are now visible as expected

e Web Server: Web Page Roles can now be duplicated

e Online mode: Would sometimes disconnect randomly

e Table Recipe: If the name of the linked struct was changed, the table values would not be visible
e UnilLogic gives compilation error if an SQL query includes an alias name

e Duplicating an array inside a struct would not keep members’ hames and comments

¢ Changing member of array name as Function In sometimes changed the current view
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